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Kurzfassung 

Im Rahmen des Verbundvorhabens TUNB Velo 2.0 wurde am Landesamt für Bergbau, Energie und 
Geologie (LBEG) ein 3D-Geschwindigkeitsmodell des Norddeutschen Beckens für Niedersachsen 
und Bremen entwickelt. Das Projekt erfolgte in Zusammenarbeit mit den staatlichen geologischen 
Diensten von Schleswig-Holstein, Mecklenburg-Vorpommern, Brandenburg und Sachsen-Anhalt un-
ter Federführung der Bundesanstalt für Geowissenschaften und Rohstoffe (BGR). Mit den resultie-
renden Geschwindigkeitsmodellen wird das Norddeutsche Becken nahezu vollständig abgedeckt. 

Am LBEG wurden regionale Intervallgeschwindigkeiten von der Basis Zechstein bis zur Gelände-
oberkante modelliert. In das Modell flossen 14 lithostratigraphische Horizonte sowie Salzstrukturen 
und Störungen ein, die überwiegend aus dem TUNB3D-Modell, ergänzend aus dem GTA3D-Modell 
und aus dem Paläogeographischen Atlas der Unterkreide stammen. Die Modellierung erfolgte in 
Aspen SKUA® V14.5, wobei aus einem Strukturmodell ein Volumenmodell erzeugt und mit seismi-
schen Geschwindigkeiten parametrisiert wurde. Der regionale Geschwindigkeitsansatz basiert auf 
bestehenden Kartenwerken; die Intervallgeschwindigkeiten wurden mithilfe der v0-k-Methode abge-
leitet. Große Teile Niedersachsens sind abgedeckt, während für Südniedersachsen und den Raum 
Osnabrück aufgrund unzureichender Datengrundlagen kein Modell erstellt werden konnte. 

Da die beteiligten geologischen Dienste auf unterschiedlichen Datengrundlagen arbeiteten, wurden 
zur Harmonisierung der Intervallgeschwindigkeiten an den Ländergrenzen verschiedene neu entwi-
ckelte Methoden eingesetzt. Das großräumige Modell ersetzt keine lokalen Geschwindigkeitsstu-
dien, stellt jedoch eine wichtige Grundlage für seismologische Analysen, Laufzeitberechnungen von 
Erdbebenwellen sowie für die Zeit-Tiefen-Umwandlung seismischer Daten dar. Eine Weiterentwick-
lung ist durch die Integration neuer Messungen und lokaler Studien vorgesehen. Das TUNB Velo 
2.0-Modell ist unter https://3d.lbeg.de/ veröffentlicht; weiterführende Geschwindigkeitsdaten sind auf 
Anfrage verfügbar. 
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Vorwort 

Die nachhaltige und sichere Nutzung des geo-
logischen Untergrundes ist eine zentrale Vo-
raussetzung für eine zukunftsorientierte Ener-
gie-, Rohstoff- und Raumplanung. Moderne 
dreidimensionale Untergrundmodelle bilden 
hierfür eine unverzichtbare, wissensbasierte 
Grundlage. Sie ermöglichen es, komplexe geo-
logische Strukturen realitätsnah abzubilden und 
belastbare Entscheidungen zu treffen – etwa 
zur tiefen Geothermie, zur Nutzung von Unter-
grundspeichern für Wasserstoff oder Erdgas so-
wie für raumplanerische Fragestellungen. 

Vor diesem Hintergrund kommt dem Projekt 
TUNB Velo 2.0 eine besondere Bedeutung zu. 
Es leistet einen wesentlichen Beitrag zur Ver-
besserung der Zeit-Tiefen-Umwandlung seismi-
scher Daten und erhöht damit die Planungssi-
cherheit bei strukturgeologischen Interpretatio-
nen. In der Seismik bezeichnet der Zeitbereich 
die Darstellung des Untergrundes anhand der 
Laufzeiten seismischer Signale, bevor diese 
mithilfe von Geschwindigkeitsmodellen in Tie-
fen umgerechnet werden. Dies ist von hoher 
Relevanz, da am Landesamt für Bergbau, Ener-
gie und Geologie rund 75 Prozent der 3D- und 
etwa 83 Prozent der 2D-seismischen Daten 
ausschließlich im Zeitbereich vorliegen.  

Mit dem im Rahmen von TUNB Velo 2.0 entwi-
ckelten Modell liegt erstmals ein konsistentes, 
regional harmonisiertes und flächendeckendes 
3D-Geschwindigkeitsmodell für Niedersachsen 
und Bremen vor, eingebettet in den geologi-
schen Kontext des Norddeutschen Beckens. Es 
stellt damit eine belastbare Grundlage im Über-
sichtsmaßstab dar – insbesondere für die Zeit-
Tiefen-Umwandlung seismischer Daten sowie 
für seismologische Analysen, etwa zur präzise-
ren Lokalisierung von Erschütterungen und Erd-
beben. 

Das Modell dient als regionaler Referenz- und 
Bezugsrahmen und ergänzt lokale Detailunter-
suchungen, ersetzt diese jedoch nicht. Auf sei-
ner Basis können künftig die im regionalen und 
lokalen Maßstab erforderlichen Anpassungen 
an komplexe strukturelle Verhältnisse, bei-
spielsweise im Bereich von Salzstrukturen so-
wie an Bohrdaten gezielt vorgenommen wer-
den.  

Besonders hervorzuheben ist die erfolgreiche 
länderübergreifende Zusammenarbeit zwi-
schen der Bundesanstalt für Geowissenschaf-
ten und Rohstoffe und den staatlichen geologi-
schen Diensten Norddeutschlands. Das Projekt 
zeigt beispielhaft, wie effiziente föderale Koope-
ration gelingen kann – auch und gerade im Um-
gang mit heterogenen und teilweise ausschließ-
lich zeitbasierten Datenbeständen. Diese Her-
ausforderungen haben zugleich wichtige Im-
pulse für methodische Weiterentwicklungen und 
eine stärkere Standardisierung in der Unter-
grundmodellierung gegeben. 

Die digitale Bereitstellung der Ergebnisse über 
das 3D-Portal NIBIS3D des LBEG unterstreicht 
den Anspruch an Transparenz, Serviceorientie-
rung und eine moderne, leistungsfähige Daten-
infrastruktur. Der Zugang zu qualitätsgesicher-
ten geowissenschaftlichen Informationen wird 
damit für Verwaltung, Wirtschaft und Wissen-
schaft nachhaltig verbessert. 

Mein ausdrücklicher Dank gilt allen an dieser 
Publikation beteiligten Fachbehörden, Projekt-
partnerinnen und -partnern sowie den Mitarbei-
tenden der beteiligten Häuser. Die engagierte, 
interdisziplinäre Zusammenarbeit dieses 
Teams bildete die Grundlage für den Erfolg von 
TUNB Velo 2.0. 

Zugleich ist dieses Geschwindigkeitsmodell 
kein Endpunkt, sondern ein wichtiger Meilen-
stein für die künftige Weiterentwicklung. Mit 
neuen seismischen Daten, zusätzlichen Bohrin-
formationen und weiterentwickelten Methoden 
wird das 3D-Modell künftig kontinuierlich fortge-
schrieben und verbessert. Damit bleibt es ein 
tragfähiges Fundament für eine verantwor-
tungsvolle und zukunftsfähige Nutzung des ge-
ologischen Untergrundes in Niedersachsen und 
Bremen. 

Ich wünsche Ihnen eine informative und anre-
gende Lektüre. 

Carsten Mühlenmeier 

Präsident LBEG 
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1. Allgemeines 

Im Rahmen des Projekts Tieferer Untergrund 
Norddeutsches Becken (TUNB, OBST & VON  
GOERNE 2025) wurde zwischen 2014 und 2022 
ein umfassendes 3D-Strukturmodell für das 
Norddeutsche Becken erstellt. Im nachfolgen-
den TUNB Velo 2.0-Projekt wurde das Struktur-
modell in ein Volumenmodell umgewandelt und 
mit seismischen Geschwindigkeiten parametri-
siert. Das TUNB Velo 2.0-Projekt hatte in Nie-
dersachsen ursprünglich eine Laufzeit vom 
01.10.2021 bis zum 30.09.2025, die Anfang 
2025 bis zum 31.12.2025 verlängert wurde. Das 
Projekt basiert auf der Verwaltungsvereinba-
rung vom 27.07.2021 zwischen der Bundesre-
publik Deutschland, vertreten durch die Bun-
desanstalt für Geowissenschaften und Roh-
stoffe (BGR), und dem Bundesland Niedersach-
sen, vertreten durch das Landesamt für Berg-
bau, Energie und Geologie (LBEG). 

1.1. Zielsetzung 

Das Projekt ist in vier Phasen untergliedert. In 
der ersten Phase 1.1 (6 Monate) lag der Fokus 
auf der Datensichtung und Datenbeschaffung, 
um eine Pilotregion zu identifizieren. Zudem 
sollten in dieser Phase Konzepte für ein einheit-
liches Vorgehen trotz heterogener Datenbe-
stände der Projektpartner entwickelt werden, 
um eine Harmonisierung der Geschwindigkeits-
modelle zu erreichen. 

In der anschließenden Phase 1.2 (12 Monate) 
war das Ziel, ein Geschwindigkeitsmodell für die 
Pilotregion zu erstellen. Dabei wurden mögliche 
Workflows getestet, und eine Best Practice Me-
thode sollte gefunden werden. Die entwickelten 
Methoden inklusive Genauigkeitsbetrachtungen 
wurden dokumentiert.  

In Phase 2 (20 Monate) war das Ziel, Geschwin-
digkeitsmodelle für die Teilregionen innerhalb 
der durch das TUNB3D-Modell abgedeckten 
Fläche Niedersachsens und Bremens zu erstel-
len. Hierbei war eine möglichst flächende-
ckende Abdeckung anzustreben. 

In Phase 3 (6 Monate) sollte die grenzübergrei-
fende Harmonisierung abgeschlossen werden. 

Die letzte Phase 4 (4 Monate) diente dem Er-
stellen des Abschlussberichts. 

2. Datengrundlage 

2.1. Koordinatenreferenzsystem 

Im Projekt wird für Niedersachsen als Koordina-
tenreferenzsystem das Europäische Terrestri-
sche Referenzsystem 1989 (ETRS89) in Ver-
bindung mit dem UTM-Koordinatensystem 
(UTM32 Nord) und Zonenkennziffer 32 verwen-
det (EPSG:4647 - ETRS89 / UTM zone 32N 
(zE-N)). 

2.2. Projektgebietsgrenze 

Als Grenze des Projektgebietes zu anderen 
Bundesländern wurden die Landesgrenzen aus 
dem Datensatz Verwaltungsgebiete 1 : 250.000 
(VG250) des Bundesamtes für Kartographie 
und Geodäsie (BKG) verwendet (Stand: 
31.12.2013). Dies entspricht der beim TUNB-
Projekt verwendeten Grenze. 

2.3. Kachelung 

Das zugrundeliegende TUNB3D-Modell für Nie-
dersachsen und Bremen wurde in 20 separaten 
Kacheln modelliert (SATTLER et al. 2022). Diese 
Einteilung wird auch für die Modellierung inner-
halb des TUNB Velo 2.0-Projekts verwendet. 
Tabelle 1 liefert eine Übersicht der Kachelna-
men und zugehörigen Kürzel, und Abbildung 1 
zeigt die Lage der Kacheln und Kachelgrenzen. 
Die Kachel Hameln ist grau dargestellt, da diese 
nicht im Rahmen des TUNB Velo 2.0-Projekts 
modelliert wurde (siehe Kapitel 2.9 „Geschwin-
digkeitsdaten: Regionale Geschwindigkeitsmo-
delle“). 
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Tab. 1:  Verwendete Kürzel und dazugehörige Kachelnamen (SATTLER et al. 2022). 

Kachelkürzel Kachelname Kachelkürzel Kachelname 
AUR Aurich NOH Nordhorn 
BHV Bremerhaven NOR Norden 
BRS Braunschweig OLD Oldenburg 
CEL Celle OSN Osnabrücker Land 
DAN Dannenberg SOL Soltau 
EMS Emsland UEL Uelzen 
HAM Hameln VEC Vechta 
HAN Hannover VER Verden 
HBR Bremen WHV Wilhelmshaven 
HIL Hildesheim WIN Winsen (Luhe) 

 

 
Abb. 1:  Beim TUNB Velo 2.0-Projekt verwendete Kacheln aus dem TUNB-Projekt (SATTLER et al. 2022).  

(Datenquelle Ländergrenzen: © GeoBasis-DE/LGLN 2024; © GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 
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2.4. Pilotregion 

Zum Testen des Workflows und der Methoden 
zur Erstellung eines mit seismischen Geschwin-
digkeiten parametrisierten Volumenmodells 
wurde eine Pilotregion festgelegt. Getestet 
wurde dabei der Workflow zur Erstellung des 
Volumenmodells, die Methodik der Parametri-
sierung, die Wahl der seismischen Geschwin-
digkeiten und Möglichkeiten der Harmonisie-
rung der Geschwindigkeiten entlang der Gren-
zen. Die Pilotregion umfasst ein Gebiet mit Lan-
desflächen aller beteiligten staatlichen geologi-
schen Dienste und damit auch gemeinsame 
Grenzen mit den benachbarten Projektpartnern. 
Die Geologie der Region weist die für Nord-
deutschland typische Salztektonik auf, und alle 
Bundesländer haben ähnliche strukturgeologi-
sche Bedingungen. Die verfügbaren Geschwin-
digkeitsinformationen sind ebenfalls hinsichtlich 

ihrer Quelle für alle Bundesländer ähnlich und 
umfassen Checkshot-Messungen in Bohrun-
gen, vereinzelte Sonic-Log-Messungen aus 
Bohrungen, seismische Processing-Geschwin-
digkeiten sowie bereits bestehende regionale 
Geschwindigkeitsmodelle. Im Vergleich zur Pi-
lotregion aus dem TUNB-Projekt (Abb. 2: blaue 
Linie) wurde die Pilotregion im Süden um ca. 
30 km an der Grenze zu Sachsen-Anhalt nach 
Westen erweitert (Abb. 2: rote Linie), um wei-
tere Bohrungen mit Geschwindigkeitsinformati-
onen einzubeziehen sowie den Salzstock 
Wustrow abzudecken. Für dessen Gebiet liegen 
2D-Tiefenmigrations-Ergebnisse vor. Die Pilot-
region entspricht für den niedersächsischen Teil 
weitestgehend der TUNB-Kachel Dannenberg. 
Diese reicht im Süden noch maximal 12 km wei-
ter nach Westen. 

 

 
Abb. 2:  Ländergrenzen mit der Pilotregion beim TUNB-Projekt (blau) und beim TUNB Velo 2.0-Projekt (rot). Außerdem ist 

die Grenze der Kachel Dannenberg eingezeichnet (grün). (Datenquelle Ländergrenzen: © GeoBasis-DE/LGLN 
2024; © GeoBasis-DE/LVermGeo SH; © GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 
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2.5. Digitales Geländemodell 

Als obere Schichtgrenze wird für das Modell das 
digitale Geländemodell (DGM) verwendet. Es 
wurde im Projekt „GTA3D – Der Geotektonische 
Atlas als 3D-Modell“ (2012) erstellt und hat ein 
regelmäßiges Raster von 250 m (BOMBIEN et al. 
2012). 

2.6. Horizonte 

Als Grundlage für die Modellierung der Ge-
schwindigkeiten wurden die Horizonte, Salz-
strukturen und Störungen aus dem TUNB3D-
Modell (SATTLER et al. 2022) verwendet.  

Als zusätzliche Schicht wird das Wealden ein-
gefügt, da dieser in der verwendeten regionalen 
Geschwindigkeitsanalyse (Kapitel 2.9 „Ge-
schwindigkeitsdaten: Regionale Geschwindig-
keitsmodelle“) separat betrachtet wurde. Die 
Modellierung des Wealdens basierte auf den 

TK200-Kartenblättern der Mächtigkeitskarte 
des Paläogeographischen Atlas (SCHOTT et al. 
1967). Zudem wurden geologische Schnitte hin-
zugezogen, die im Rahmen des Geotektoni-
schen Atlas (GTA)-Projektes (KOCKEL 1998) auf 
Basis von Seismik-Daten erstellt wurden und in 
den Berichten zu den einzelnen TK100-Kacheln 
veröffentlicht sind (BALDSCHUHN et al. 1996, 
2001). Somit untergliedert sich im TUNB Velo 
2.0-Projekt die Schicht Oberjura und Wealden 
(jo-Wd) aus dem TUNB3D-Modell in den Malm 
und das darüber liegenden Wealden.  

Tabelle 2 liefert eine Zusammenfassung der 
verwendeten Horizonte mit ihrem stratigraphi-
schen Alter, den vorherrschenden Gesteinsar-
ten, der zugehörigen Bezeichnung und den ver-
wendeten Abkürzungen. Die beiden im Ver-
gleich zum TUNB-Projekt veränderten Schich-
ten sind hervorgehoben. 

 

Tab. 2:  Im TUNB Velo 2.0-Projekt modellierte geologische Horizonte. 

Abk. 
TUNB 
Velo 
2.0 

Bezeichnung 
LBEG Stratigraphisches Alter* Gesteinsart** Abk. 

TUNB 
Bezeichnung 
TUNB-Projekt 

dgm Digitales  
Geländemodell 

  GOK Erdoberfläche 

tolm-
tolo 

Rupel bis 
Oberoligozän 

Mitteloligozän und Oberoligozän:  
Basis Mitteloligozän (Rupel) (NP23)  
bis jüngstes Oberoligozän (Neochatt) 
(NP25) 

Ton, Sand tolR Basis Rupelium 

tpao-
teou 

Oberpaläozän 
bis Untereozän 

Oberpaleozän und Untereozän:  
Basis Oberpaleozän (Landen) (NP8) 
bis zum jüngsten Untereozän  
(Untereozän 4) (NP13) 

Ton, Sand, Braunkohle t Basis Tertiär 

kro Oberkreide 
Oberkreide: Basis der tiefsten Ober-
kreide (Cenoman) bis zum höchsten 
Dan 

Kalkstein, Mergelstein,  
örtlich Eisenerz kro Basis Oberkreide 

kru Marine  
Unterkreide 

Unterkreide: Basis der tiefsten marinen 
Unterkreide (Valangin) bis zur höchsten 
Unterkreide (Oberalb) 

Tonstein, Mergelstein,  
örtlich Sandstein 

kru- 
marin 

Basis marine  
Unterkreide 

Wd Wealden 
Basis des tiefsten Wealdens bis zum 
höchsten Wealden/Berrias  
(Bückeberg-Formation) 

Sandstein jo  

jo Oberjura Malm: Basis des tiefsten Oberjuras 
(Oxford) 

Gips-/Anhydritstein,  
Kalkstein, Mergelstein jo Basis Malm 

jutco-
jmclo Dogger 

Dogger: Basis hoher Lias  
(Obertoarcium) bis zum obersten  
Dogger (Callovium) 

dunkelgrauer Tonstein,  
selten Sandstein,  
örtlich Eisenerz 

jm Basis Dogger 

juhe-
jutcu Lias 

Lias: Basis tiefster Lias (Hettangium) 
bis zum Oberen Lias (Untertoarcium, 
Posidonien-Schiefer) 

dunkelgrauer Tonstein,  
selten Sandstein,  
örtlich Eisenerz 

ju Basis Lias 
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Tab. 2:  Im TUNB Velo 2.0-Projekt modellierte geologische Horizonte (Fortsetzung). 

Abk. 
TUNB 
Velo 
2.0 

Bezeich-
nung LBEG Stratigraphisches Alter* Gesteinsart** Abk. 

TUNB 
Bezeichnung 
TUNB-Projekt 

ko Oberer  
Keuper Rhät (Oberer Keuper): Basis Rhät 

Sandstein, Tonstein,  
Mergelstein,  
Gips-/Anhydritstein 

ko Basis Rhät 

ku-km 
Unterer bis 
Mittlerer  
Keuper 

Keuper: Basis tiefster Keuper  
(Lettenkeuper) bis zum Oberen 
Keuper 

Sandstein, Tonstein,  
Mergelstein,  
Gips-/Anhydritstein 

ku Basis Unterer 
Keuper 

so-m Röt und  
Muschelkalk 

Röt und Muschelkalk: Basis  
Oberer Buntsandstein (Rötsalinar)  
bis zum Oberen Muschelkalk  
(Ceratitenschichten) 

Kalkstein, Mergelstein,  
Gips-/Anhydritstein,  
Tonstein 

so Basis Oberer 
Buntsandstein 

sm Mittlerer  
Buntsandstein 

Mittlerer Buntsandstein: Basis  
Mittlerer Buntsandstein bis zum  
höchsten Mittleren Buntsandstein 

roter Sandstein,  
Tonstein sm Basis Mittlerer 

Buntsandstein 

su Unterer  
Buntsandstein 

Unterer Buntsandstein: Basis  
tiefster Unterer Buntsandstein  
(Calvörde-Folge) 

roter Sandstein,  
Tonstein,  
örtlich Kalkstein 

su Basis Unterer 
Buntsandstein 

z Zechstein 

Zechstein: Basis tiefster Zechstein 
(Kupferschiefer der Werra-Folge) 
(T1) bis zum höchsten Zechstein  
(Mölln-Folge) (z7) 

Steinsalz,  
z. T Kalisalz,  
Gips-/Anhydritstein,  
Kalkstein, Tonstein 

z Basis Zechstein 

    
Top-
Base-
ment 

Top  
Prä-Zechstein 

* nach SATTLER et al. (2022); ** nach HEUNISCH et al. (2017). 

 

2.7. Salzstrukturen 

Beim Erstellen der Volumenmodelle wurden die 
im TUNB-Projekt modellierten Salzstrukturen 
verwendet. Zusätzlich wurden nicht im TUNB-
Projekt verwendete Salzstrukturen, die im 
GTA3D (BOMBIEN et al. 2012) vorhanden sind, 
ebenfalls berücksichtigt. Dies betraf die Kacheln 
Braunschweig (Salzstrukturen: Calberlah, Eh-
men, Nettgau, Örrel, Schneflingen-Ehra, Vor-
hop, Wesendorf, Weyhausen) und Celle (Salz-
strukturen: Böstlingen-Sülze-Weesen-Lutterloh, 
Wathlingen, Wienhausen). In den Gebieten der 
Kacheln Braunschweig und Hannover existie-
ren bekannte Salzstrukturen, die weder im 
TUNB-Projekt noch im GTA3D-Projekt model-
liert wurden. Aufgrund der fehlenden Strukturin-
formation konnten diese auch nicht im TUNB 
Velo 2.0-Projekt berücksichtigt werden. Eine 
Übersicht über die vorhandenen und modellier-
ten Salzstrukturen sowie deren Quelle kann Ta-
belle 6 im Anhang entnommen werden. 

2.8. Störungen 

Im Rahmen des TUNB Velo 2.0-Projekts wur-
den die im TUNB-Projekt modellierten Störun-
gen ebenfalls verwendet. Aus modelliertechni-
schen Gründen wurden die Störungen, die nur 
einen senkrechten Versatz in der Basis Zech-
stein darstellen, weggelassen. Die Basis Zech-
stein stellt die untere Begrenzung des Modells 
dar. Die Geschwindigkeitsverteilung des Mo-
dells wird daher kaum durch diese Störungen 
beeinflusst. Tabelle 3 liefert eine Übersicht über 
die Modellbestandteile der einzelnen Kacheln. 
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Tab. 3:  Übersicht der Modellbestandteile der einzelnen Kacheln. 

Kachel Horizonte  
TUNB 

Horizonte  
TUNB  

Velo 2.0 
Störungen  

TUNB 
Störungen  

TUNB  
Velo 2.0 

Salzstrukturen  
TUNB 

Salzstrukturen 
TUNB Velo 2.0 

AUR 14 15 58 58 15 15 
BHV 14 14 27 27 8 8 
BRS 14 15 125 122 0 8 
CEL 14 15 131 126 5 8 
DAN 14 15 55 55 11 11 
EMS 14 15 124 122 11 11 
HAN 14 15 75 75 0 0 
HBR 14 15 87 86 10 10 
HIL 14 15 76 76 8 8 

NOH 14 15 114 114 0 0 
NOR 12 12 71 70 8 8 
OLD 14 15 86 86 7 7 
OSN 14 15 86 85 0 0 
SOL 14 14 54 54 10 10 
UEL 14 15 61 61 11 11 
VEC 14 15 141 141 1 1 
VER 14 15 79 58 8 8 
WHV 14 15 24 24 8 8 
WIN 14 14 36 36 9 9 

Gesamt 14 15 1594 1476 130 141 
 

 

2.9. Geschwindigkeitsdaten: Regionale 
Geschwindigkeitsmodelle 

Für die westdeutschen Bundesländer (Nieder-
sachsen und Schleswig-Holstein) erstellten 
JARITZ et al. (1991) im Rahmen des Projekts 
GTA ein regionales Geschwindigkeitsmodell für 
das Nordwestdeutsche Becken. Es basiert auf 
der Auswertung von etwa 1000 Geophonver-
senkmessungen (GVM) aus Tiefbohrungen, 
Vertical-Seismic-Profiling (VSP)-Messungen 
von etwa 300 Bohrungen sowie Betrachtungen 
zur regionalen Geologie, wie beispielsweise der 
lokalen Absenkungshistorie der geologischen 
Schichten. Das Geschwindigkeitsmodell basiert 

auf dem „v0-k-Ansatz“. Dabei werden die Inter-
vallgeschwindigkeiten in den einzelnen Schich-
ten aus einer theoretischen Oberflächenge-
schwindigkeit (v0, im Folgenden wie bei JARITZ 
et al. (1991) als VNN bezeichnet) und einem 
schichtabhängigen Gradienten k berechnet. 
JARITZ et al. (1991) stellten die theoretischen 
Oberflächengeschwindigkeiten VNN in Karten für 
10 Sedimentschichten von Tertiär bis Unterer 
Buntsandstein dar. In der Publikation von JARITZ 
et al. (1991) sind dies Übersichtskarten der the-
oretischen Oberflächengeschwindigkeiten VNN 
für ganz Niedersachsen und Schleswig-Hol-
stein. Abbildung 3 zeigt beispielhaft die publi-
zierte Karte für die Oberkreide. 
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Abb. 3:  Von JARITZ et al. (1991) publizierte Karte der Oberflächengeschwindigkeit VNN für die Oberkreide. 

Zusätzlich existieren auch die TK100-Arbeits-
karten der Arbeitsgruppe von JARITZ et al. 
(1991). Für Niedersachsen sind die vorhande-
nen Arbeitskarten in Abbildung 4 dargestellt. 
Die Kartenblätter C3106 Lathen und C3110 Pa-
penburg, die im Bereich der TUNB-Kacheln 
Emsland und Oldenburg liegen, sind für alle 
Schichten verloren gegangen. Hier wurden die 
Werte anhand der Karten aus der Publikation 
(JARITZ et al. 1991) interpoliert. 
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Abb. 4:  Vorhandene TK100-Arbeitskarten der Oberflächengeschwindigkeiten für Niedersachsen, beispielhaft für die Ober-

kreide. 

 

Abbildung 5 zeigt den in Abbildung 4 rot mar-
kierten Bereich aus der Kachel Uelzen für die 
Oberkreide vergrößert. Hier ist der Umriss des 
Salzstocks Niendorf-II-Bodenteich schwarz dar-
gestellt. Die Bohr-Lokationen, für die den Auto-
ren Geschwindigkeitsinformationen für die 
Oberkreide zur Verfügung standen, sind als rote 

Punkte markiert. Daneben ist die für diese Boh-
rung berechnete theoretische Oberflächenge-
schwindigkeit rot notiert. Daraus haben die Au-
toren Isolinien gleicher VNN-Werte abgeleitet 
und mit Bleistift in die Karte eingezeichnet. Für 
die Geschwindigkeitsmodellierung wurden die-
se Arbeitskarten digitalisiert und verwendet. 
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Abb. 5:  Ausschnitt aus der Arbeitskarte von JARITZ et al. (1991) im Gebiet der Kachel Uelzen für die Oberkreide. 

 

Zu jeder dieser Schichten bestimmten JARITZ 
et al. (1991) einen Gradienten k. Tabelle 4 lie-
fert einen Überblick über die im TUNB3D-Mo-
dell erstellten Horizonte, die Schichteinteilung 
von JARITZ et al. (1991) und den zugehörigen 
Gradienten. 
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Tab. 4:  Im TUNB3D-Modell modellierte Horizonte, Horizonte mit Geschwindigkeitsinformationen nach JARITZ et al. (1991) 
und zugehöriger Gradient. 

TUNB3D-Modell Modell nach JARITZ et al. Gradient 
Rupel bis Oberoligozän 

Tertiär und Quartär 0,7 
Oberpaläozän bis Untereozän 
Oberkreide Oberkreide 1,2–0,9 
Marine Unterkreide Unterkreide 0,8 

Oberjura und Wealden 
Wealden 0,7 
Malm 0,2 

Dogger Dogger 0,5 
Lias Lias 0,5 
Oberer Keuper 

Keuper 0,5 
Unterer bis mittlerer Keuper 
Röt und Muschelkalk Röt und Muschelkalk 0,3 
Mittlerer Buntsandstein 

Unterer und Mittlerer Buntsandstein 0,45 
Unterer Buntsandstein 
Zechstein Zechstein  

 

 

Die Intervallgeschwindigkeiten Vint können in 
der Tiefe z für die jeweilige Schicht mittels der 
Formel Vint = VNN + (k * z) bestimmt werden. Die 
Geschwindigkeiten des Zechsteins hängen 
nicht wesentlich von der Teufe ab, da Salz unter 
zunehmendem Druck nicht stärker kompaktiert 
wird. Hier wurde eine konstante Geschwindig-
keit von 4500 m/s angenommen. Die von JARITZ 
et al. (1991) erstellten Karten der Oberflächen-
geschwindigkeit decken das Norddeutsche Be-
cken für Niedersachsen und Schleswig-Holstein 
ab, reichen jedoch nicht weit genug nach Sü-
den, um die Kachel Hameln damit zu modellie-
ren. 

2.10. Geschwindigkeitsdaten: Seismik 

In der Pilotregion existieren ca. 125 seismische 
Profile mit Geschwindigkeitsinformationen 
(Abb. 6). Die Stapelgeschwindigkeiten wurden 
aus den seismischen Plots gewonnen, indem 
die Diagramme digitalisiert und die darin enthal-
tenen Geschwindigkeitstabellen per Texterken-
nung erfasst wurden. 
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Abb. 6:  Für den niedersächsischen Teil der Pilotregion verfügbare seismische Linien mit Geschwindigkeitsinformationen. 

(Datenquelle Ländergrenzen: © GeoBasis-DE/LGLN 2024; © GeoBasis-DE/LVermGeo SH; © GeoBasis-DE / 
BKG 2024 / dl-de/by-2-0) 

 

Bei der Berechnung der Intervallgeschwindig-
keiten aus Seismikdaten sind insbesondere vier 
große Surveys eingegangen, deren Lage in Ab-
bildung 6 farblich gekennzeichnet sind. Der Sur-
vey Gorleben im Bereich des gleichnamigen 
Salzstocks besteht aus 36 Profilen aus den Jah-
ren 1982 bis 1991 sowie weiteren 14 aus dem 
Jahr 1995. Der Dannenberg-Survey wurde von 
1978 bis 1987 aufgenommen. Im Grenzgebiet 
zu Mecklenburg-Vorpommern liegen 16 seismi-
sche Profile, die aus den Jahren 1972 und 1973 
stammen und als DDR-Survey bezeichnet wer-
den. Westlich an die Pilotregion grenzt zudem 

der 2.5D-Survey Dahlenburg, der im Jahr 2001 
akquiriert wurde. Er umfasst 13 Profile, die – mit 
Ausnahme eines Profils – parallel zueinander 
verlaufen, sodass insgesamt eine reguläre Auf-
nahmekonfiguration entsteht, die mit der Geo-
metrie eines 3D-Surveys vergleichbar ist. Für 
diese vier Surveys wurden aus den digitalisier-
ten Stapelgeschwindigkeiten Intervall- und 
Durchschnittsgeschwindigkeiten berechnet 
(Abb. 7 bis Abb. 10). 
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Abb. 7:  Survey Dannenberg mit Stapelgeschwindigkeiten (links), errechneten Intervallgeschwindigkeiten (Mitte) und  

errechneten Durchschnittsgeschwindigkeiten (rechts; Aspen EPOS® V14.2). 
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Abb. 8:  Survey Gorleben mit Stapelgeschwindigkeiten (links), errechneten Intervallgeschwindigkeiten (Mitte) und errech-

neten Durchschnittsgeschwindigkeiten (rechts; Aspen EPOS® V14.2). 
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Abb. 9:  DDR-Profile mit Stapelgeschwindigkeiten (links), errechneten Intervallgeschwindigkeiten (Mitte) und errechneten 

Durchschnittsgeschwindigkeiten (rechts; Aspen EPOS® V14.2). 
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Abb. 10:  2.5D-Survey Dahlenburg mit Stapelgeschwindigkeiten (links), errechneten Intervallgeschwindigkeiten (Mitte) und 

errechneten Durchschnittsgeschwindigkeiten (rechts; Aspen EPOS® V14.2). 

 

Bei den dargestellten Intervallgeschwindigkei-
ten ist für alle Surveys die breite Streuung zu 
erkennen. Dies ist nicht geologisch zu erklären, 
sondern kann mit Ungenauigkeiten beim Picken 
der Stapelgeschwindigkeiten in der Seismik 
oder mit Fehlern in den Tabellen der Stapelge-
schwindigkeiten erklärt werden. 

2.11. Seismik 

Zur Qualitätskontrolle des Geschwindigkeitsmo-
dells wurden 3D-Seismikdaten verwendet. Für 
die Kachel Soltau wurden dafür die Surveys 
Soltau_2012 und Soehlingen_2016 verwendet. 
Beide Datensätze wurden von CGG prozes-
siert. Für die Kachel Vechta gibt es den Survey 
Scholen_Ridderade_2015, welcher von Wes-
ternGeco reprozessierte Daten sind. Alle ver-
wendeten Surveys liegen sowohl zeit- als auch 
tiefenmigriert vor. Zudem existieren Geschwin-
digkeitsinformationen. 
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3. Datenaufbereitung 

Die Modellierungen wurden in Aspen SKUA® 
V14.5 durchgeführt. Um die in der Software ver-
wendeten Befehle besser nachvollziehen zu 
können, sind diese nicht übersetzt worden, son-
dern die englischen Begriffe sind kursiv ge-
schrieben. 

3.1. Integration des Wealdens 

Die Mächtigkeit des Wealdens, die in den 
TK200-Kartenblättern des Paläogeographi-
schen Atlas (SCHOTT et al. 1967) dargestellt ist 
(Abb. 11), wurde mit ArcGIS digitalisiert. 

 
Abb. 11:  Mächtigkeitskarte des Wealdens aus dem Paläogeographischen Atlas (SCHOTT et al. 1967). 
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Die daraus resultierenden Shapefiles der Isoli-
nien der Mächtigkeiten und der Ausdehnung 
des Wealdens wurden in die Software Aspen 
SKUA® V14.5 importiert. Zur Modellierung wur-
den hier zunächst die Mächtigkeiten auf einer 
Surface mittels des Application Wizard interpo-
liert. Hierbei wurde aufgrund der Zellgröße des 
finalen Voxets eine Mindestmächtigkeit von 
25 m festgelegt. Dadurch wurde verhindert, 
dass Randbereiche 0 m mächtig sind. Durch 
den Abstand zwischen Basis Malm und Basis 
Unterkreide kann die finale Mächtigkeit jedoch 
unter 25 m liegen. Um ausgehend von der 
Mächtigkeit einen Basis-Horizont des Wealdens 
in das Modell einfügen zu können, wurde die 
Topfläche der TUNB-Schicht Oberes Jura 
(Malm und Wealden) benötigt. Im Anhang ist die 
Erstellung einer Topfläche in Aspen SKUA® 

V14.5 und die danach folgenden Arbeitsschritte 
detailliert beschrieben. Ausgehend von der 
Malm-Topfläche wurde die Mächtigkeit des 
Wealdens abgezogen und anschließend kon-
trolliert, ob die so entstandene Schicht oberhalb 
der Malm-Basisfläche liegt. Außerdem wurde 
die Basisfläche Wealden auf die Bereiche ge-
schnitten, für die das Wealden laut dem Palä-
ogeographischen Atlas (SCHOTT et al. 1967) 
verbreitet ist. An den Rändern der Fläche und 
im Bereich der Salzstrukturen kam es zu Rand-
effekten, durch die die Fläche stark nach unten 
bzw. bei Salzstrukturen nach oben gebogen 
wurde und hier teilweise andere Schichten 
schnitt. Diese Randeffekte wurden entfernt. Ab-
bildung 12 zeigt die Wealden-Basisfläche vor 
und nach diesem Bearbeitungsschritt. 

 
Abb. 12:  Wealden vor (links) und nach (rechts) der Bearbeitung fehlerhafter Tiefenwerte entlang der niedersächsischen 

Grenze (Aspen SKUA® V14.5). 

 

Im Bereich der Kachel Bremen ist im Paläogeo-
graphischen Atlas (SCHOTT et al. 1967) zwar 
eine Verbreitung des Wealdens dargestellt 
(Abb. 13), es sind jedoch keine Mächtigkeits-
werte eingezeichnet. 
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Abb. 13:  Verbreitung des Wealdens im Bereich Bremen (Paläogeographischer Atlas, SCHOTT et al. (1967); Aspen SKUA® 

V14.5). 

 

In den Schnitten des Geotektonischen Atlas 
(GTA) durch den Salzstock Arsten-Osterholz 
(Abb. 14) ist zu erkennen, dass das Wealden 
Mächtigkeiten von etwa 200 m nur im Bereich 
der Salzstrukturflanken erreicht und ansonsten 
nur geringmächtig bis gar nicht abgelagert ist. 

 

 

 

 

 
Abb. 14:  Verbreitung des Wealdens im Bereich des Salzstocks Arsten-Osterholz (BALDSCHUHN et al. 1996). 
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Aufgrund der Unsicherheit der Verbreitung und 
Mächtigkeit des Wealdens in dieser Region und 
der finalen Modellauflösung von 250 x 250 
x 25 m wurde entschieden, das Wealden für 
den Bereich um Bremen, für den keine Mächtig-
keiten in der Karte des Paläogeographischen 

Atlas eingezeichnet waren, nicht zu modellie-
ren. Abbildung 15 zeigt die Tiefenwerte und 
Verbreitung der final modellierten Basisfläche 
Wealden mit der TK500-Karte aus dem Palä-
ogeographischen Atlas (SCHOTT et al. 1967) im 
Hintergrund. 

 
Abb. 15:  Tiefenwerte und Verbreitung der modellierten Basisfläche Wealden mit der TK500-Karte aus dem Paläogeogra-

phischen Atlas (SCHOTT et al. 1967) im Hintergrund. Die Karte ist im Anhang vergrößert dargestellt (Aspen SKUA® 
V14.5). 

 

3.2. Aufbereiten der 
VNN100-Geschwindigkeiten 
nach JARITZ et al. (1991) 

In ArcGIS wurden die Isolinien und eingezeich-
neten Geschwindigkeitswerte aus den TK100-
Arbeitskarten von JARITZ et al. (1991) digitali-
siert und anschließend in Aspen SKUA® V14.5 
zusammen mit den Arbeitskarten importiert 
(Abb. 16). Eine detailliertere Beschreibung der 
in Aspen SKUA® V14.5 genutzten Befehle be-
findet sich im Anhang. Um ausgehend von den 
Isolinien flächendeckende VNN-Werte interpolie-
ren zu können, wurden die Stützstellen der Iso-
linien auf einen regulären Abstand von etwa 
200 m gesetzt. 
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Abb. 16:  Arbeitskarte von JARITZ et al. (1991) für die Oberkreide im Bereich Dannenberg mit den digitalisierten Isolinien und 

Punktwerten (Aspen SKUA® V14.5). 

 

Neben den digitalisierten Isolinien sind in den 
Arbeitskarten auch einzelne VNN-Werte einge-
zeichnet. Um beide auf einer Fläche zu interpo-
lieren, mussten diese als PointsSet zusammen-
gefasst werden. Im Application Wizard konnte 
mit diesem dann die Interpolation durchgeführt 
werden. Dabei wurden so viele Iterationen an-
gewendet, bis keine Änderungen bei den Wer-
ten mehr erkennbar waren. Anschließend wur-
den die interpolierten VNN-Karten mit den Ar-
beitskarten von JARITZ et al. (1991) verglichen. 
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Abb. 17:  Arbeitskarte von JARITZ et al. (1991) für die Oberkreide im Bereich Dannenberg mit den digitalisierten Isolinien und 

Punktwerten und zusätzlich konstant gesetzten Regionen (Aspen SKUA® V14.5). 

 

In den Arbeitskarten hatten JARITZ et al. (1991) 
über Pfeile größeren Regionen konstante VNN-
Werte zugewiesen. Um diese korrekt zu interpo-
lieren, wurden zusätzlich Regions mit konstan-
ten VNN-Werten gepickt. Die Bereiche mit VNN-
Werten wurden als PointsSet exportiert und 
dann als zusätzliche Constraints bei der Inter-
polation genutzt. Abbildung 17 zeigt neben den 
digitalisierten Isolinien auch die Bereiche, für 
die konstante VNN-Werte gepickt wurden. Wei-
tere Iterationen der Interpolation wurden über 
Surface -> Interpolation -> Interpolate Property 
durchgeführt. Für die Oberkreide sind die inter-
polierten Isolinien und die verwendeten Con-
straints in Abbildung 18 dargestellt. 
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Abb. 18:  Arbeitskarte von JARITZ et al. (1991) für die Oberkreide im Bereich Dannenberg mit den digitalisierten Isolinien und 

Punktwerten. Außerdem sind konstant gesetzte Regionen sowie die interpolierten Isolinien (blau) eingezeichnet 
(Aspen SKUA® V14.5). 

 

Bei den Arbeitskarten von JARITZ et al. (1991) 
fehlten die TK100-Kartenblätter C3106 Lathen 
und C3110 Papenburg, die im Bereich der 
TUNB-Kacheln Emsland und Oldenburg liegen. 
In der Lücke wurden die VNN-Werte aus den 
Übersichtskarten der Publikation interpoliert. 
Abbildung 19 zeigt den Bereich der Kartenlücke 
und die dort verwendete Karte aus der Publika-
tion sowie die digitalisierten Isolinien beispiel-
haft für die Oberkreide. 
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Abb. 19:  Arbeitskarten und publizierte Karte von JARITZ et al. (1991) für die Oberkreide mit den digitalisierten Isolinien aus 

der Publikation und den Arbeitskarten. Die TUNB-Kacheln sind gelb dargestellt (Aspen SKUA® V14.5). 

 

In Abbildung 20 sind zusätzlich in Blau die inter-
polierten Isolinien eingezeichnet. 

 
Abb. 20:  Arbeitskarten und publizierte Karte von JARITZ et al. (1991) für die Oberkreide mit den digitalisierten Isolinien  

sowie den interpolierten Isolinien. Die TUNB-Kacheln sind gelb dargestellt (Aspen SKUA® V14.5). 
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4. Modellierprozesse: Erstellen 
eines Volumenmodells 

4.1. Erzeugen eines Volumenmodells 

Zur Erstellung eines Geschwindigkeitsmodells 
musste das im Rahmen des vorangegangenen 
TUNB-Projekts erstellte Strukturmodell in ein 
Volumenmodell umgewandelt werden. Die Mo-
dellierung erfolgte mit der Software Aspen 
SKUA® V14.5. Diese ermöglicht die Erstellung 
eines parametrisierbaren Volumenmodells mit 
unterschiedlichen Ansätzen, von denen zwei 
während des TUNB Velo 2.0-Projekts getestet 
wurden. Im Kapitel 4.3 „Erzeugen eines Volu-
menmodells über ein Voxet“ ist das Vorgehen 
dokumentiert, bei dem zunächst ein Voxet er-
stellt wird, indem die geologischen Schichten 
als Regions gespeichert werden. Im Kapitel 4.4 
„Erzeugen eines Volumenmodells über den 
Structure and Stratigraphy-Workflow (SnS-
Workflow)“ wird die Erstellung eines Volumen-
modells über den SnS-Workflow beschrieben. 

4.2. Verwenden eines Startprojekts 

Unabhängig davon, ob das Volumenmodell 
über ein Voxet oder über den SnS-Workflow er-
zeugt wurde, kam für alle Kacheln ein gemein-
sames Startprojekt zum Einsatz – analog zum 
Vorgehen im TUNB-Projekt (SATTLER et al. 
2022). Aspen SKUA® V14.5 erstellt einen pro-
jekteigenen räumlichen Übersetzungsvektor, 
um die vielstelligen Koordinaten der räumlichen 
Objekte im Modell aus Kapazitätsgründen als 
Datentyp Float zu speichern. Der räumliche 
Übersetzungsvektor wird von Aspen SKUA® 
V14.5 in Bezug auf das erste ins Projekt gela-
dene Objekt erzeugt. Unterschiede im Überset-
zungsvektor führen dazu, dass Objekte, die in 

separat erstellten Projekten erzeugt wurden, an 
der gemeinsamen Grenze nicht genau aneinan-
derpassen. Daher wurde das Startprojekt aus 
dem TUNB-Projekt (SATTLER et al. 2022) ver-
wendet und um die für alle Kacheln benötigten 
Objekte erweitert. 

4.3. Erzeugen eines Volumenmodells 
über ein Voxet 

Zunächst wurde ein Voxet mit einer lateralen 
Auflösung von 200 m und einer vertikalen Auf-
lösung von 20 m erzeugt. Dadurch konnten ge-
ologische Strukturen noch hinreichend genau 
abgebildet werden, ohne dass dabei die erfor-
derliche Speichergröße zu groß wurde. Die ho-
rizontale Größe des Voxets wurde dabei an die 
Ausdehnung der Kachel angepasst, so dass 
das Voxet jeweils die komplette Kachel abdeckt. 
Um den Speicherplatzbedarf zu minimieren, 
wurden die Voxets so gedreht, dass sie zu der 
räumlichen Orientierung der Kacheln passen 
(Voxet -> New -> Digitize in 3D View -> Rotated 
Rectangle). Die Oberkante des Voxets wurde 
so gewählt, dass sie über dem DGM liegt, wel-
ches den oberen Abschluss des Modells dar-
stellt. Die Unterkante liegt tiefer als die Basis 
Zechstein. Im Voxet wurden die geologischen 
Schichten als Regions gespeichert, wofür die 
Topflächen der Schichten benötigt wurden. Da-
für wurde eine Kopie der jeweiligen Basis-
schicht mittels Apply Script On Object über die 
Geländeoberkante geschoben und anschlie-
ßend über den Befehl Remove Crossovers -> 
Push down iterativ von oben nach unten ge-
schoben. Anschließend konnten die Regions 
über Region -> Initialize from Geologic Feature 
initiiert werden. Abbildung 21 zeigt das Voxet 
mit den geologischen Schichten als Regions im 
Gebiet der gemeinsamen Pilotregion mit den 
benachbarten Projektpartnern. 
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Abb. 21:  Oben: Voxet mit den geologischen Schichten als Regions. 
Dreifach überhöhte Darstellung (Aspen SKUA® V14.5).  
Links: Dazugehörige Lageskizze. Der Pfeil zeigt die Blick-
richtung.  
(Datenquelle Ländergrenzen:  
© GeoBasis-DE/LGLN 2024;  
© GeoBasis-DE/LVermGeo SH;  
© GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 

 

 

4.4. Erzeugen eines Volumenmodells 
über den Structure and 
Stratigraphy-Workflow 
(SnS-Workflow) 

Eine andere Möglichkeit zur Berechnung eines 
Volumens in Aspen SKUA® V14.5 ist die An-
wendung des SnS-Workflows. Hierbei erzeugt 
der Workflow aus den Horizonten, den Salzkör-
pern und den Störungen ein Volumenmodell. 
Der Workflow basiert auf einer definierten Ab-
folge von Modellierschritten, die im Folgenden 
vorgestellt werden. 

4.4.1. Stratigraphische Säule 

Für die Anwendung des SnS-Workflows wird 
die stratigraphische Säule (Stratigraphic Co-
lumn) benötigt, die dem Workflow den stratigra-
phischen Kontext vorgibt. In Abbildung 22 ist die 
für die Modellierung verwendete Stratigraphie 
dargestellt. Hierbei ist zu beachten, dass die 
modellierten Horizonte Basishorizonte sind und 
dies in der stratigraphischen Säule auch so an-
gegeben werden muss. Zusätzlich zu der im 
TUNB-Projekt verwendeten stratigraphischen 
Säule wurde das Wealden mit eingefügt. 
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Abb. 22:  Beim TUNB Velo 2.0-Projekt verwendete stratigraphische Säule in Aspen SKUA® V14.5. 

 

4.4.2. Umgang mit Salzstrukturen im 
SnS-Workflow 

Salzkörper müssen im SnS-Workflow als ge-
schlossene Körper (Surfaces) vorliegen. Dies 
kann über zwei Varianten gelöst werden. Einer-
seits konnte dies erreicht werden, indem der 
Horizont Top Zechstein mit den Umhüllenden 
der Salzstrukturen als eine geschlossene Flä-
che verbunden wurde, die über die Modellgren-
zen hinausragte. Dieses Vorgehen wurde bei 

der Kachel Dannenberg getestet, bei den da-
nach modellierten Kacheln jedoch nicht, da es 
sich als sehr zeitaufwendig und fehleranfällig im 
SnS-Workflow herausstellte. Eine alternative 
Vorgehensweise besteht darin, die Salzstruktu-
ren jeweils als geschlossene Flächenkörper zu 
modellieren. Im Folgenden wird der methodi-
sche Ablauf grundlegend beschrieben; die in 
Aspen SKUA® V14.5 verwendeten Befehle sind 
im Anhang aufgeführt. Ausgangspunkt waren 
PointsSets, die aus den ursprünglichen Salz-
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strukturflächen der TUNB3D- bzw. GTA3D-Mo-
delle abgeleitet wurden. Auf Basis dieser Punkt-
mengen wurden ellipsenförmige Volumenkör-
per generiert. Anschließend wurden die origina-
len Salzstrukturen als Constraints gesetzt und 
die neuen Flächen an diese interpoliert. Auch 
diese Bearbeitungen waren sehr zeitaufwendig 
und führten beim Ausführen des SnS-Work-
flows häufig zu Fehlern. Diese umfassten zum 
einen die Salzkörper selber, wie beispielsweise 
zu spitze Dreiecke oder sich schneidende Flä-
chen der triangulierten Salzstruktur-Umhüllen-
den. Zum anderen traten aber auch Fehler im 
räumlichen Bezug der Salzkörper zu anderen 
Objekten auf, wie beispielsweise fehlerhafte 
Schnittflächen mit den Störungsflächen. Daher 
war es effizienter, die Salzkörper beim SnS-
Workflow nicht zu berücksichtigen und diese 
dann über Regions im finalen Voxet einzufügen. 
Der Nachteil ist, dass diese dann nicht im Geo-
logic Grid und SKUA Model enthalten sind. Für 
das finale Geschwindigkeits-Voxet entstehen 
dadurch jedoch keine Unterschiede. 

4.4.3. Definition des Volume of Interest 

Im Schritt Volume of Interest wurde das Model-
liergebiet für die jeweilige Kachel festgelegt. 
Dieses wird größer als die eigentliche Kachel-
grenze gewählt, um an den Kachelgrenzen die 
finalen Geschwindigkeiten benachbarter Voxets 
vergleichen zu können. Zudem wurden Kachel-
grenzen mit kompliziertem Grenzverlauf, in der 
Regel Kacheln entlang der niedersächsischen 
Grenze, vereinfacht, so dass das Landesgebiet 
vollständig innerhalb des Modelliergebiets liegt 
und möglichst gerade Außengrenzen hat. Da-
her decken die resultierenden Geschwindig-
keitsmodelle jedoch auch geringfügig Gebiete 
ab, die nicht in Niedersachsen und Bremen lie-
gen. Für die durchgeführte Grenzharmonisie-
rung (Kapitel 6 „Grenzharmonisierung“) muss 
das modellierte Gebiet mindestens zwei Kilo-
meter in die am TUNB Velo 2.0-Projekt beteilig-
ten Bundesländer hineinreichen. 

4.4.4. Erstellen von Störungsfeatures 

Der SnS-Workflow erstellt ein Störungsnetz-
werk (Fault Network), wozu die im TUNB-Pro-
jekt erstellten Störungsfeatures verwendet wur-
den. Vereinzelt mussten Störungsflächen, wel-

che Fehler bei der Ausführung des SnS-Work-
flows erzeugten, weggelassen werden. Dies be-
traf in der Regel sich kreuzende Störungsflä-
chen. Daher wurde die kleinere Störungsfläche 
bzw. die mit dem geringeren vertikalen Versatz 
der Horizonte entfernt. Tabelle 3 liefert eine 
Übersicht über die Anzahl an nicht modellierten 
Störungsflächen. Hierbei bildet die Kachel Ver-
den eine Ausnahme. Während bei allen ande-
ren Kacheln maximal fünf Störungsflächen (we-
niger als 4 %) nicht berücksichtigt werden konn-
ten, lag diese Zahl bei 21 von 79 Störungsflä-
chen (~27 %) für die Kachel Verden. Die Model-
lierung dieser Kachel erwies sich im SnS-Work-
flow aufgrund der hohen strukturellen Komple-
xität als besonders anspruchsvoll. Daher wurde 
als pragmatischer Kompromiss auf die Berück-
sichtigung von Störungsflächen verzichtet, um 
überhaupt ein belastbares Modellierungsergeb-
nis zu erhalten. 

4.4.5. Erstellen des Fault Network 

Aus den Störungsfeatures wird im nächsten 
Schritt des SnS-Workflows ein räumliches Stö-
rungsnetzwerk erstellt. Dafür wird eine Auflö-
sung von 800 m horizontal und 400 m vertikal 
verwendet, was der im TUNB-Projekt verwen-
deten Auflösung entspricht. 

4.4.6. Erstellen von Fault Blocks 

Der Schritt Build Fault Blocks dient dazu, die im 
Fault Network räumlich definierten Störungen in 
das Volume of Interest einzufügen. Dies ge-
schah mit einer Auflösung von 500 m horizontal 
und 200 m vertikal, was ebenfalls der Auflösung 
des TUNB-Projekts entsprach. 

4.4.7. Horizontmodellierung im Schritt 
Modeling Horizons 

Im Schritt Build All Horizons werden die Hori-
zonte für das Geologic Grid erstellt. Dabei kann 
stufenweise ausgewählt werden, ob das globale 
Modell eher glatt (Global smooth) oder genau 
an den Eingangsdaten (Fit data) sein soll. Ge-
nerell wurde bei allen Schichten zunächst die 
mittlere Stufe zwischen den beiden Extremen 
gewählt. Wenn Fehlermeldungen des SnS-
Workflows auftraten oder sich Unstimmigkeiten 
bei der Qualitätskontrolle zeigten, wurde der 
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Parameter für einzelne Schichten verändert. 
Der Parameter Auto-ignore data around faults 
wurde auf 200 m gesetzt. 

Problematisch für die Durchführung dieses Mo-
dellierschrittes sind Horizonte, bei denen Abla-
gerungen auf den Salzstrukturen liegen, die 
nicht mit den tieferliegenden Schichten gleichen 
lithostratigraphischen Alters verbunden sind. 
Dies betraf hauptsächlich Ablagerungen der 
Oberkreide für einzelne Salzstrukturen. Diese 
Bereiche wurden nicht im Workflow berücksich-
tigt und sind somit nicht im Geschwindigkeits-
modell entsprechend der ursprünglichen strati-
graphischen Zuordnung parametrisiert. Der sich 
daraus ergebende Fehler ist vernachlässigbar, 
da die Mächtigkeiten der nicht berücksichtigten 
Horizonte auf den Salzstrukturen gering sind 
(meist im Bereich von unter 100 m). Zudem wur-
den solche Ablagerungen im abschließend ver-
wendeten Geschwindigkeitsmodell von JARITZ 
et al. (1991) nicht betrachtet. 

Nachdem die Modellhorizonte generiert wur-
den, erfolgte eine umfangreiche Qualitätskon-
trolle. Hierbei ist vor allem der Vergleich der neu 
berechneten Horizonte mit den Eingangsdaten 
(Surfaces der Horizonte aus dem TUNB3D-Mo-
dell) wichtig. Häufige Fehler betrafen Horizonte, 
die nicht auf der gesamten Fläche der Kachel 
vorhanden sind. Hier vergrößerte der Workflow 
die Horizonte oft in Gebiete, in denen diese gar 
nicht vorkommen. Dies konnte korrigiert wer-
den, indem die Verbreitung des Horizontes im 
SnS-Workflow explizit berücksichtigt wurde. 
Dazu wurde die Outline des Horizontes als ge-
schlossene Curve erzeugt und dem jeweiligen 
Horizon Feature zugewiesen. Anschließend 
wurde im Schritt Selecting Data: Horizons die 
Outline ausgewählt und deren Role auf Non-
erosion Outline gesetzt (detaillierte Beschrei-
bung aller Schritte im Anhang). 

4.4.8. Erstellen des Geologic Grid 

Im letzten Schritt des SnS-Workflows wurde das 
Geologic Grid erstellt. Hier wurde aufgrund der 
Auflösung, die auch bereits für das Voxet ver-
wendet wurde, eine laterale Zellgröße (Cell size 
im Schritt Compute Unit Areal Extension) von 

200 m gewählt. Für die vertikale Zellgröße der 
Zelle (Set Cell Thickness im Schritt Compute 
Unit Thickness) wurde aus demselben Grund 
20 m verwendet. 

Das Ergebnis des SnS-Workflows ist ein Geolo-
gic Grid, welches bereits ein parametrisierbares 
Volumenmodell darstellt. 

5. Modellierprozesse: 
Parametrisierung 
mit seismischen 
Geschwindigkeiten 

5.1. Zuweisen der Geschwindigkeiten 
im Voxet 

Nachdem das Voxet mit den Regions erstellt 
wurde (Kapitel 4.3 „Erzeugen eines Volumen-
modells über ein Voxet“), konnte die von JARITZ 
et al. (1991) bestimmte Oberflächengeschwin-
digkeit VNN einer Schicht in die Zellen der jewei-
ligen Region übertragen werden (Voxet -> Pro-
perty -> Transfer Property by Vertical Projec-
tion). Mittels Apply Script on Object kann über 
die Formel Vint = VNN + (k * fabs(Z)) für die jewei-
lige Region die Intervallgeschwindigkeit Vint für 
jede Zelle berechnet werden. Dabei ist Z die 
Tiefe und k der Gradient der jeweiligen Schicht 
(Tab. 4). Für den Zechstein sowie die Salzstruk-
turen wurde Vint konstant auf 4500 m/s gesetzt 
(siehe Kapitel 2.9 „Geschwindigkeitsdaten: Re-
gionale Geschwindigkeitsmodelle“). Einzelne 
Zellen waren keiner Region zugeordnet und be-
kamen daher auch keine Geschwindigkeits-
werte. Diese wurden nachträglich gesetzt, in-
dem zunächst die Zellen ohne Geschwindigkei-
ten als Region definiert wurden. Aus den Zellen 
mit Geschwindigkeitsinformation wird ebenfalls 
eine Region erzeugt und daraus ein PointsSet 
erstellt. Mittels Voxet -> Property -> Paint on Re-
gion -> With PointsSet wurden die Geschwin-
digkeiten in die No-Data Region geschrieben. 
Abbildung 23 zeigt das Voxet mit den Intervall-
geschwindigkeiten für die Kachel Dannenberg. 
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Abb. 23:  Intervallgeschwindigkeiten für die Kachel Dannenberg (Aspen SKUA® V14.5). Die Intervallgeschwindigkeiten wur-

den im Voxet zugewiesen. 

 

5.2. Parametrisierung mittels Reservoir 
Properties (RP)-Workflow 

Das Ergebnis des SnS-Workflows (Kapitel 4.4 
„Erzeugen eines Volumenmodells über den 
Structure and Stratigraphy-Workflow (SnS-
Workflow)“) ist ein Geologic Grid. Es gibt zwei 
unterschiedliche Möglichkeiten, diesem Volu-
menmodell Intervallgeschwindigkeiten zuzuwei-
sen. Eine davon ist der RP-Workflow von Aspen 
SKUA® V14.5. Dieser setzt voraus, dass die Ge-
schwindigkeiten als Geschwindigkeitsfunktio-
nen (Velocity Function) vorliegen. 

5.2.1. Geschwindigkeiten 
aus der Seismik 

Die eingescannten Stapelgeschwindigkeiten 
(Kapitel 2.10 „Geschwindigkeitsdaten: Seis-
mik“) lagen im PRN- bzw. ProMAX-Format als 
eine Datei pro Linie vor. Beide Formate beste-
hen aus formatiertem Text mit Leerzeichen und 
enthalten die CMP-Nummer der Geschwindig-
keitsfunktion, die Zweiweglaufzeit und die Sta-
pelgeschwindigkeit. Im ProMAX-Format gibt es 
zusätzlich vier Headerzeilen. Nachdem die Ko-
ordinaten der CMP-Lokationen in Aspen 
EPOS® V14.2 geladen wurden, konnten diese 
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Dateien in Aspen EPOS® V14.2 über ASCII-Im-
port als Vertical Function (Type: Velocity; Sub-
type: Stacking (NMO) Time) eingelesen wer-
den. Die Stapelgeschwindigkeiten lagen im 
Zeit-Bereich vor und wurden in Aspen EPOS® 
V14.2 zunächst in Intervallgeschwindigkeiten im 
Zeitbereich und dann in die Tiefen-Domäne ge-
wandelt. Für die Konvertierung wurden be-
stimmte Zeit- bzw. Tiefenintervalle herangezo-
gen. Diese orientierten sich an den Zeiten, für 
die Stapelgeschwindigkeiten vorlagen, und 
nicht an geologischen Horizonten. Die errech-
neten Intervallgeschwindigkeiten wurden als 
ASCII-Datei im TDQ-Format exportiert, die an-
schließend über File -> Import -> Velocity Data 
-> TDQ in Aspen SKUA® V14.5 importiert 
wurde. 

Die Eingangsdaten für den RP-Workflow waren 
das Geologic Grid aus dem SnS-Workflow so-
wie die importierten Geschwindigkeitsfunktio-
nen. Die Intervallgeschwindigkeiten wurden 
dann im Workflow mittels Kriging auf das Geo-
logic Grid interpoliert. 

5.2.2. Erzeugen eines  
Geschwindigkeitsmodells 
nach dem v0-k-Ansatz 

Mit dem Modul Aspen SeisEarth® V14.2 lässt 
sich ein Geschwindigkeitsmodell erstellen, das 
durch theoretische Oberflächengeschwindigkei-
ten, einen schichtspezifischen Gradienten so-
wie die jeweilige Tiefe definiert ist (v0-k-Ansatz). 
Dafür mussten für jede Schicht zwei Grids aus 
Aspen SKUA® V14.5 in Aspen SeisEarth® V14.2 
importiert werden, eines mit den Geometrie-In-
formationen des Horizontes und ein weiteres 
mit den theoretischen Oberflächengeschwindig-
keiten nach JARITZ et al. (1991). Diese Informa-
tionen wurden über File -> Save Interpretation -
> Save 2D Grid Property (Property: Velocity, In-
tervall Vp) aus Aspen SKUA® V14.5 an Aspen 
EPOS® V14.2 übertragen. Im Interpretation 
Data Manager wurde kontrolliert, dass die ein-
geladenen Grids mit Geometrie-Informationen 
als Data Type „Depth“ und die mit Geschwindig-
keitsinformationen als Data Type „Velocity“ ge-
laden wurden. Geschwindigkeitsmodelle kön-
nen in Aspen EPOS® V14.2 im Modul Global 
Velocity Model erstellt werden. Dabei wurde 
Model Type: Horizon Based, Domain: Depth 
und Velocity Type: Interval Vp (v0-k) verwendet. 
Über Add Horizon(s) wurden zunächst die Hori-

zonte in Tiefe eingeladen und dann unter Ve-
locity Source -> Velocity Map die theoretischen 
Oberflächengeschwindigkeiten nach JARITZ 
et al. (1991). Für die Berechnung des Ge-
schwindigkeitsmodells wurde ein Gradient be-
nötigt, der wie die theoretischen Oberflächenge-
schwindigkeiten JARITZ et al. (1991) entnom-
men ist. Mit dem Befehl Create Velocity Volume 
wurden die Intervallgeschwindigkeiten in Tiefe 
innerhalb eines vorher definierten Volumens be-
rechnet. Die Intervallgeschwindigkeiten konnten 
im Modul Paradigm Session Manager -> Verti-
cal Functions extrahiert werden. An Pseudo-
CMP-Lokationen wurden mit einem lateralen 
Abstand von 25 m und einem Tiefen-Sampling 
von 10 m Geschwindigkeitsfunktionen erstellt. 
Diese wurden analog zu den Daten aus der 
Seismik im TDQ-Format exportiert und an-
schließend über File -> Import -> Velocity Data 
-> TDQ in Aspen SKUA® V14.5 importiert.  

Sie dienten neben dem Geologic Grid aus dem 
SnS-Workflow als Eingangsdaten für den RP-
Workflow. Wie bei denen aus der Seismik wur-
den die Intervallgeschwindigkeiten im Workflow 
mittels Kriging auf das Geologic Grid interpo-
liert. 

5.3. Parametrisierung mittels 
Apply Script on Object 

Wenn ein Geschwindigkeitsmodell nach dem 
v0-k-Ansatz über die theoretischen Oberflä-
chengeschwindigkeiten VNN, einen Gradienten k 
pro Schicht und die Tiefe Z definiert ist, so kön-
nen die Intervallgeschwindigkeiten auch direkt 
in Aspen SKUA® V14.5 berechnet werden. 
Dazu wurden zunächst die Oberflächenge-
schwindigkeiten VNN in die Zellen des Geologic 
Grid geschrieben (Voxet -> Property -> Transfer 
Property by Vertical Projection). Anschließend 
konnten die Intervallgeschwindigkeiten Vint, 
analog zur Vorgehensweise beim Voxet in Ka-
pitel 5.1 „Zuweisen der Geschwindigkeiten im 
Voxet“, mittels Apply Script on Object über die 
Formel Vint = VNN + (k * fabs(Z)) für die jeweilige 
Region im Geologic Grid berechnet werden. 

5.4. Übertragen der Geschwindigkeiten 
auf ein Voxet 

Sowohl beim RP-Workflow als auch bei der Pa-
rametrisierung mittels Apply Script on Object 
wurden die Intervallgeschwindigkeiten auf das 
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Geologic Grid geschrieben. Da das angestrebte 
Ergebnis jedoch ein Voxet mit Geschwindig-
keitsinformationen sein sollte, mussten die In-
tervallgeschwindigkeiten noch übertragen wer-
den. In Aspen SKUA® V14.5 müssen dazu die 
Geschwindigkeiten zunächst im SKUA Model 
gespeichert werden, und von dort können sie in 
die Zellen des Voxets geschrieben werden. 
Dazu wird der Property Model Editor des SKUA 
Models (SKUA Model -> Property -> Grid-Less 
Property Editor) genutzt. Hier wurde über Add 
Property die Intervallgeschwindigkeit hinzuge-
fügt. Anschließend wurde bei jeder Schicht die 
Intervallgeschwindigkeit auf die des Geologic 
Grids gesetzt (Variable Type auf From Grid Pro-
perty  
-> Geologic_Model auswählen -> Update Vari-
able Definition). Für den Zechstein wurde die In-
tervallgeschwindigkeit konstant auf 4500 m/s 
gesetzt (Variable Type auf Constant). Für die 
darunter liegenden Schichten (vorwiegend Rot-
liegendes, teilweise auch Ablagerungen aus 
dem Oberkarbon) existieren keine Literatur-
werte. Hier wurde eine konstante Geschwindig-
keit von 5200 m/s für die niedersächsischen 
Modellkacheln angenommen. 

Analog zu dem in Kapitel 4.3 „Erzeugen eines 
Volumenmodells über ein Voxet“ beschriebe-
nen Vorgehen wurde ein Voxet erstellt und die 
Geschwindigkeiten mittels SKUA Model -> Pro-
perty -> Paint Voxet auf dieses übertragen. Au-
ßerdem wurden die geologischen Schichten als 
Regions auf das Voxet übertragen: SKUA Mo-
del -> Property -> Transfer Stratigraphy and Ge-
ologic Time to Voxet. 

5.4.1. Einfügen der Salzkörper als 
Regions im Voxet 

Die gleichzeitige Integration von Störungen und 
Salzkörpern im SnS-Workflow führte zu zahlrei-
chen Fehlermeldungen, da der Kontakt von Stö-
rungen und Salzkörpern im Workflow nicht defi-
niert werden kann. Daher war es effizienter, die 
Salzkörper erst im Voxet als Regions einzufü-
gen und für diese Regions dann die Intervallge-
schwindigkeiten zu setzen. Um die Region der 
Salzstrukturen korrekt initialisieren zu können, 
mussten diese als geschlossene Flächen vorlie-
gen. Die Region konnte dann über Voxet -> Re-
gion -> Initialize from Geologic Feature gesetzt 
werden. Dazu durfte das jeweilige Salzfeature 
ausschließlich die geschlossene Salzfläche ent-

halten. Anschließend wurde die Intervallge-
schwindigkeit im Salzkörper auf 4500 m/s mit-
tels Voxet -> Property -> Set Constant und der 
entsprechenden Region gesetzt. 

5.4.2. Qualitätskontrolle 

Nachdem das Voxet mit den Intervallgeschwin-
digkeiten für die jeweilige Kachel erstellt war, 
wurde es auf Plausibilität geprüft. Dabei zeigte 
sich, dass es vereinzelte Zellen ohne Ge-
schwindigkeitsinformationen gab, obwohl diese 
innerhalb des Modelliergebiets lagen. Um diese 
noch zu setzen, wurden zunächst die Zellen 
ohne Geschwindigkeiten als Region definiert 
(Voxet -> Region -> Initialize from Property No-
Data Value). Die daraus entstandene Region 
musste noch bearbeitet werden, um nur Zellen 
zu berücksichtigen, die unterhalb des DGM und 
innerhalb des Modelliergebiets liegen. Aus den 
Zellen mit Intervallgeschwindigkeits-Werten 
wurde ebenfalls eine Region erzeugt und dar-
aus ein PointsSet erstellt. Mittels Voxet -> Pro-
perty -> Paint on Region -> With PointsSet wur-
den die Intervallgeschwindigkeiten der benach-
barten Zelle in die No-Data Region geschrie-
ben. 

5.4.3. Umwandeln der 
Intervallgeschwindigkeiten in 
Durchschnittsgeschwindigkeiten 

Für die Veröffentlichung der Daten wurden aus 
den Intervallgeschwindigkeiten im Tiefenbe-
reich auch die Durchschnittsgeschwindigkeiten 
im Zeitbereich erstellt. Dazu mussten zunächst 
die Intervallgeschwindigkeiten extrapoliert wer-
den, so dass keine nicht definierten Werte mehr 
im Modell vorhanden waren. Anschließend wur-
den die Durchschnittsgeschwindigkeiten in As-
pen SKUA® V14.5 mit dem Befehl Velocity -> 
Velocity Conversion -> Voxet and Seismic 
Lines: in Different Domains von Intervallge-
schwindigkeiten in Tiefe (depth interval) in 
Durchschnittsgeschwindigkeiten in Zeit (time 
average) umgewandelt. Im Voxet wurden diese 
dann auf den Bereich geschnitten, in dem vor 
der Interpolation Intervallgeschwindigkeiten vor-
lagen. 
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6. Grenzharmonisierung 

In der Pilotregion wurden die Geschwindigkeits-
modelle der beteiligten staatlichen geologi-
schen Dienste harmonisiert und in ein gemein-
sames Voxet übertragen. Dieses hat eine Auflö-
sung von 250 m in horizontaler Richtung und 
25 m in vertikaler Richtung. Im finalen Voxet 
wurden die Intervallgeschwindigkeiten unter-
halb der Basis Zechstein auf nicht definiert 
(NDV) gesetzt. Damit unterscheidet sich das 
Voxet für die Kachel Dannenberg hinsichtlich 
Auflösung und Intervallgeschwindigkeiten unter 
der Basis Zechstein von den anderen Kacheln 
für Niedersachsen und Bremen. 

6.1. Grenze Niedersachsen – 
Schleswig-Holstein 

Die Geschwindigkeitsmodelle von Niedersach-
sen und Schleswig-Holstein passten im Grenz-
bereich bereits vor der Grenzharmonisierung 
größtenteils zusammen, da sie beide auf JARITZ 

et al. (1991) beruhen. Im Verlauf des gegensei-
tigen Abstimmungsprozesses wurden geringfü-
gige Differenzen bezüglich der Tiefenlage der 
Horizonte bereinigt und die Horizontgeometrien 
seitens Schleswig-Holsteins entsprechend an-
gepasst. Für den mittleren Jura (jm) sind die 
theoretischen Oberflächengeschwindigkeiten in 
den Arbeitskarten von JARITZ et al. (1991) nicht 
eindeutig. An den Isolinien stehen jeweils zwei 
Geschwindigkeitswerte, die sich um bis zu 
300 m/s unterscheiden. Hier bestimmten die 
Projektmitarbeitenden in Schleswig-Holstein die 
optimalen Werte, indem sie die Horizonte mit 
den beiden unterschiedlichen Geschwindig-
keitsmodellen in den Zeitbereich konvertierten 
und mit Seismik im Zeitbereich verglichen. Es 
zeigte sich, dass die niedrigeren Geschwindig-
keitswerte zu besseren Ergebnissen führten, 
daher wurden diese für die Modellierung ver-
wendet. Abbildung 24 zeigt eine Übersichts-
karte zu den in Abbildung 25 dargestellten 
Schnitten durch die Geschwindigkeitsmodelle 
Niedersachsens und Schleswig-Holsteins an 
der gemeinsamen Grenze. Darin ist zu erken-
nen, dass beide Geschwindigkeitsmodelle an 
der Grenze identisch sind. 

 

 

Abb. 24:  Übersichtskarte zu den in Abbildung 25 dargestellten Sektionen 
(hier in Rot). Der Pfeil zeigt die Blickrichtung.  
(Datenquelle Ländergrenzen:  
© GeoBasis-DE/LGLN 2024;  
© GeoBasis-DE/LVermGeo SH;  
© GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 

 

 
Abb. 25:  Beispielhafter Schnitt durch die Voxets von Niedersachsen und Schleswig-Holstein zum Vergleich der Intervall-

geschwindigkeiten an der gemeinsamen Grenze (Aspen SKUA® V14.5). 

SH 

NI 
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6.2. Grenze Niedersachsen – 
Mecklenburg-Vorpommern 

Das Geschwindigkeitsmodell für Mecklenburg-
Vorpommern basiert auf dem regionalen Ge-
schwindigkeitsmodell von REINHARDT (1977, 
1988) und weiteren regionalen Modellen, die 
zwischen 1980 und 1990 erstellt wurden. Daher 

wiesen die Geschwindigkeitsmodelle von Nie-
dersachsen und Mecklenburg-Vorpommern vor 
der Grenzharmonisierung deutlich größere Un-
terschiede auf als die zwischen Niedersachsen 
und Schleswig-Holstein. Abbildung 26 zeigt die 
Übersichtskarte für die in Abbildung 27 darge-
stellte Intervallgeschwindigkeit vor der Grenz-
harmonisierung. 

 
 

 

Abb. 26:  Übersichtskarte zu der in Abbildung 27 und Abbildung 29 darge-
stellten Sektion (hier in Rot). Der Pfeil zeigt die Blickrichtung.  
(Datenquelle Ländergrenzen:  
© GeoBasis-DE/LGLN 2024;  
© GeoBasis-DE/LVermGeo SH;  
© GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 

 

 
Abb. 27:  Beispielhafter Schnitt durch die Voxets von Niedersachsen und Mecklenburg-Vorpommern zum Vergleich der  

Intervallgeschwindigkeiten an der gemeinsamen Grenze (Aspen SKUA® V14.5). 

 

Aufgrund der Differenzen in den Intervallge-
schwindigkeiten an der gemeinsamen Grenze 
musste ein anderer Ansatz für die Harmonisie-
rung gewählt werden. Um die Geometrie der 
Horizonte und damit einhergehenden Änderun-
gen der Intervallgeschwindigkeiten zu erhalten, 
wurden die den Geschwindigkeitsmodellen zu-
grunde liegenden theoretischen Oberflächenge-
schwindigkeiten und Gradienten interpoliert. 
Dafür wurden von Mecklenburg-Vorpommern 
die theoretischen Oberflächengeschwindigkei-
ten für die in Niedersachsen und Schleswig-Hol-
stein verwendeten Schichten bestimmt. In der 

Pilotregion auf dem Gebiet Mecklenburg-Vor-
pommerns ist das Geschwindigkeitsfeld durch 
mehrere Bohrungen belegt. Deshalb wurde de-
ren Geschwindigkeitsmodell nach Niedersach-
sen hinein interpoliert. Dazu wurde die Oberflä-
chengeschwindigkeit aus Mecklenburg-Vor-
pommern in die verwendeten Karten der Ober-
flächengeschwindigkeit für Niedersachsen inte-
griert und in einem ca. 2 km breiten Bereich in-
terpoliert (Abb. 28). 
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Abb. 28:  Extrahieren (links) und Interpolieren (rechts) der Oberflächengeschwindigkeiten, beispielhaft für die Oberkreide 

(Aspen SKUA® V14.5). (Datenquelle Ländergrenzen: © GeoBasis-DE/LGLN 2024; © GeoBasis-DE/LVermGeo 
SH; © GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 

 

Das Vorgehen bei den Gradienten war iden-
tisch. Die Intervallgeschwindigkeiten wurden 
anschließend mit den aktualisierten Daten be-
rechnet. In Abbildung 29 sind Sektionen nach 

der Grenzharmonisierung aus Mecklenburg-
Vorpommern und Niedersachsen dargestellt, 
die sich an der Grenze schneiden. 

 
Abb. 29:  Beispielhafter Schnitt durch die Voxets von Niedersachsen und Mecklenburg-Vorpommern zum Vergleich der In-

tervallgeschwindigkeiten an der gemeinsamen Grenze nach der Grenzharmonisierung (Aspen SKUA® V14.5). Die 
Lage ist identisch mit der in Abbildung 26 dargestellten Karte. 

 

Für den Bereich des Buntsandsteins unter-
scheiden sich die Intervallgeschwindigkeiten 
nach der Harmonisierung. Hier wurden die In-
tervallgeschwindigkeiten verschiedenen Tiefen-
intervallen zugeordnet. Bei der in Niedersach-
sen genutzten Schichteinteilung von JARITZ 
et al. (1991) wurden Röt und Muschelkalk (so-
m) zusammengefasst. In der Schichteinteilung 
nach REINHARDT (1977), die in Mecklenburg-
Vorpommern verwendet wurde, sind Röt und 

Muschelkalk separat betrachtet, mit vergleichs-
weise hohen Intervallgeschwindigkeiten für den 
Muschelkalk. Die unterschiedliche Einteilung 
der Intervalle ist auch in Abbildung 29 zu erken-
nen und verursacht einen abrupten Übergang 
der Intervallgeschwindigkeiten an der Grenze 
für diese Tiefe. Die Durchschnittsgeschwindig-
keiten in diesen Schichten sind jedoch harmoni-
siert. Für eine Umwandlung von seismischen 
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oder interpretierten Daten vom Zeit- in den Tie-
fenbereich und umgekehrt werden Durch-
schnittsgeschwindigkeiten verwendet. Daher 
führt die Diskrepanz bei den Intervallgeschwin-
digkeiten zu keinem Fehler, sollte das Ge-
schwindigkeitsmodell für diesen Zweck verwen-
det werden. 

6.3. Grenze Niedersachsen – 
Brandenburg 

Das Geschwindigkeitsmodell Brandenburgs ba-
siert auf REINHARDT (1988) und unterscheidet 
sich hinsichtlich Geometrie und Intervallge-
schwindigkeiten deutlich von dem niedersächsi-
schen Geschwindigkeitsmodell. Abbildung 30 
zeigt die Übersichtskarte zu den in Abbil-
dung 31 und Abbildung 33 dargestellten Sektio-
nen. 

 

Abb. 30:  Übersichtskarte zu den in Abbildung 31 und Abbildung 33 dargestell-
ten Sektionen. Zudem ist der Umriss des Salzstocks Gorleben-Ram-
bow in Hellblau dargestellt (Datenquelle Salzstockkarte: © BGR, Han-
nover, 2025). Der Pfeil zeigt die Blickrichtung.  
(Datenquelle Ländergrenzen:  
© GeoBasis-DE/LGLN 2024;  
© GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 

 
Abb. 31:  Beispielhafter Schnitt durch die Voxets von Niedersachsen und Brandenburg zum Vergleich der Intervallgeschwin-

digkeiten an der gemeinsamen Grenze vor der Grenzharmonisierung (Aspen SKUA® V14.5). Der Salzstock Gorle-
ben-Rambow wird von beiden Sektionen geschnitten (siehe Übersichtskarte Abb. 30). 

 

Hier wurde die Harmonisierung durch eine ge-
wichtete Interpolation der Intervallgeschwindig-
keiten erreicht. Das Verfahren wurde am Lan-
desamt für Geologie und Bergwesen Sachsen-
Anhalt entwickelt. Dafür wurde zunächst ein Ge-
wichtsfaktor für Niedersachsen und einer für 
Brandenburg für eine insgesamt 4 km breite 
Pufferzone entlang der Grenze bestimmt. Die 

Gewichtungsfaktoren sind 2 km innerhalb des 
jeweiligen Bundeslandes (also auf dem Rand 
der Pufferzone) auf eins und 2 km außerhalb 
auf null gesetzt. Dazwischen werden sie so in-
terpoliert, dass jeder Gewichtungsfaktor an der 
Grenze 0,5 beträgt (Abb. 32). Der Grenzverlauf 
und damit auch der Verlauf der Pufferzone sind 
dabei etwas vereinfacht. 
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Abb. 32:  Wichtungsfaktoren für Brandenburg entlang der Grenze zwischen Niedersachsen und Brandenburg  

(Aspen SKUA® V14.5). Der Grenzverlauf wurde für die Interpolation vereinfacht.  
(Datenquelle Ländergrenzen: © GeoBasis-DE/LGLN 2024; © GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 

 

Entlang eines zu jeder Seite der Grenze 2 km 
breiten Streifens berechnen sich die gewichte-
ten Intervallgeschwindigkeiten (Vintweighted) nach 

Vintweighted = GewichtungsfaktorNI * VintNI +  
GewichtungsfaktorBB * VintBB 

Das bedeutet, dass sich die gewichteten Inter-
vallgeschwindigkeiten an der Grenze zu 50 % 
aus den niedersächsischen und zu 50 % aus 
den brandenburgischen Geschwindigkeiten zu-
sammensetzen. Abbildung 33 zeigt die Schnitt-

punkte zwischen Niedersachsen und Branden-
burg nach der Harmonisierung. Der Vorteil die-
ser Methode besteht darin, dass sie auch dann 
angewendet werden kann, wenn die Geometrie 
der Schichten unterschiedlich ist, während vor-
handene Informationen über Intervallgeschwin-
digkeiten entlang der Grenze beibehalten und 
genutzt werden. Nach der Grenzharmonisie-
rung gehen die Intervallgeschwindigkeiten der 
beiden Modelle in einem 4 km breiten Streifen 
ineinander über, sodass sie an der Grenze iden-
tisch sind. 

 
Abb. 33:  Beispielhafter Schnitt durch die Voxets von Niedersachsen und Brandenburg zum Vergleich der Intervallgeschwin-

digkeiten an der gemeinsamen Grenze nach der Grenzharmonisierung (Aspen SKUA® V14.5). Der Salzstock  
Gorleben-Rambow wird von beiden Sektionen geschnitten (siehe Übersichtskarte Abb. 30). 
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6.4. Grenze Niedersachsen – 
Sachsen-Anhalt 

Für die Grenze zwischen Niedersachsen und 
Sachsen-Anhalt wurde identisch vorgegangen 
wie an der Grenze zwischen Niedersachsen 
und Brandenburg und eine gewichtete Interpo-
lation der Intervallgeschwindigkeiten angewen-
det. Abbildung 34 zeigt eine Übersichtskarte zu 
den Schnittstellen aus Abbildung 35 und Abbil-
dung 36.  

 

 

 

Abb. 34:  Übersichtskarte zu den in Abbildung 35 und Abbildung 36 
dargestellten Sektionen. Der Pfeil zeigt die Blickrichtung.  
(Datenquelle Ländergrenzen:  
© GeoBasis-DE/LGLN 2024;  
© GeoBasis-DE/LVermGeo SH;  
© GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 

 
Abb. 35:  Beispielhafter Schnitt durch die Voxets von Niedersachsen und Sachsen-Anhalt zum Vergleich der Intervallge-

schwindigkeiten an der gemeinsamen Grenze vor der Grenzharmonisierung (Aspen SKUA® V14.5).  
Die zugehörige Übersichtskarte ist in Abbildung 34 dargestellt. 

 

In Abbildung 35 sind Schnitte an der Grenze 
zwischen Niedersachsen und Sachsen-Anhalt 
vor der Harmonisierung der Intervallgeschwin-
digkeiten dargestellt. Während die Intervallge-
schwindigkeiten sich vor der Grenzharmonisie-
rung noch deutlich unterscheiden, sind diese an 
der Grenze nach der Harmonisierung identisch 

(Abb. 36). Dennoch ist zu erkennen, dass au-
ßerhalb des Interpolationsgebiets (4 km breiter 
Streifen entlang der Grenze) die Modelle auf un-
terschiedlichen Geschwindigkeitsmodellen be-
ruhen und die Geschwindigkeitsintervalle ande-
ren Schichtpaketen zugeordnet wurden. 
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Abb. 36:  Beispielhafter Schnitt durch die Voxets von Niedersachsen und Sachsen-Anhalt zum Vergleich der Intervallge-

schwindigkeiten an der gemeinsamen Grenze nach der Grenzharmonisierung (Aspen SKUA® V14.5).  
Die zugehörige Übersichtskarte ist in Abbildung 34 dargestellt. 

 

7. Ergebnisse und Auswertung 

7.1. Workflow zum Erstellen des 
Volumenmodells und der 
Parametrisierung mit 
seismischen Geschwindigkeiten 

Für die Kachel Dannenberg, die für Niedersach-
sen weitestgehend der Pilotregion entspricht, 
wurde ein Volumenmodell sowohl direkt über 
ein Voxet (Kapitel 4.3 „Erzeugen eines Volu-
menmodells über ein Voxet“) als auch über den 
SnS-Workflow (Kapitel 4.4 „Erzeugen eines Vo-
lumenmodells über den Structure and Strati-
graphy-Workflow (SnS-Workflow)“) erzeugt. Ab-
bildung 37 zeigt eine Übersichtskarte mit der In-
tervallgeschwindigkeit im niedersächsischen 
Teil der Pilotregion in einer Tiefe von 1550 m. 
Im Schnitt durch das Geschwindigkeitsmodell 
(Lokation des Schnitts rot markiert in Abb. 37) 
zeigte sich, dass die Regions im Bereich der 
Salzstrukturen fehlerhaft berechnet wurden 
(Abb. 38 und Abb. 39, markiert mit ① und ②). 
Insbesondere Überhang von Salzstrukturen 
wurden nicht der korrekten Region zugewiesen. 
Im Gegensatz dazu erstellt der SnS-Workflow 
auch bei komplexer Geologie korrekte Regions 
im Bereich der Salzkörper. Dies ist auch der 
Fall, wenn mit dem SnS-Workflow zunächst nur 
die Modellierung ohne Salzköper erfolgte (die 

anderen Schichten gehen dann durch die Salz-
körper hindurch) und die Salzstrukturen an-
schließend als geschlossene Ellipsoide einge-
fügt wurden. Ein weiterer Vorteil des SnS-Work-
flows ist, dass die Zellen entlang der Schicht-
grenzen verlaufen und nicht wie bei der Voxet-
Lösung starren Würfeln entsprechen. Daher ist 
die Auflösung des Modells aus dem SnS-Work-
flow höher als beim direkten Zuweisen von Re-
gions im Voxet. Die Volumenmodelle der Ka-
cheln außerhalb der Pilotregion wurden nach 
Auswertung der dort durchgeführten Tests mit-
hilfe des SnS-Workflows erzeugt.  

Beim Vergleich des Geschwindigkeitsmodells, 
bei dem die Geschwindigkeiten über den RP-
Workflow zugewiesen wurden (Abbildung 39), 
mit dem Modell, bei dem die Geschwindigkeiten 
über die Formel in Apply Script im Geologic Grid 
bestimmt wurden (Abb. 40), zeigten sich nur ge-
ringe Unterschiede. Differenzen sind beispiels-
weise an den Flanken des südwestlichen Salz-
stocks und der Basis Unterer Bundsandstein zu 
Zechstein zu erkennen (siehe Pfeile in Abb. 39 
und Abb. 40). Da der Aufwand, die Intervallge-
schwindigkeiten mit Aspen SeisEarth® zu erzeu-
gen, deutlich größer ist als über die Formel im 
Geologic Grid und die Unterschiede im Ergeb-
nis vernachlässigbar sind, wurden für die weite-
ren Kacheln die Intervallgeschwindigkeiten nur 
über diese Methode erzeugt. 
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Abb. 37:  Karte der Pilotregion mit den Intervallge-
schwindigkeiten in Niedersachsen in einer 
Tiefe von 1550 m (Aspen SKUA® V14.5). 
Der in Abbildung 38 bis Abbildung 41 ge-
zeigte Schnitt ist rot eingezeichnet.  
(Datenquelle Ländergrenzen:  
© GeoBasis-DE/LGLN 2024;  
© GeoBasis-DE/LVermGeo SH;  
© GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 

 
Abb. 38:  Kachel Dannenberg: Schnitt durch das Geschwindigkeitsmodell mit den Salzstrukturen Köstorf-Rosenthal im Süd-

westen und Gülze-Sumte im Nordosten (Aspen SKUA® V14.5). Die geologischen Einheiten wurden als Regions im 
Voxet bestimmt. 

 
Abb. 39:  Kachel Dannenberg: Schnitt durch das Geschwindigkeitsmodell mit den Salzstrukturen Köstorf-Rosenthal im Süd-

westen und Gülze-Sumte im Nordosten (Aspen SKUA® V14.5). Das Volumenmodell wurde über den SnS-Work-
flow erstellt. Die Zuweisung der Intervallgeschwindigkeiten erfolgte über den RP-Workflow. 
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Abb. 40:  Kachel Dannenberg: Schnitt durch das Geschwindigkeitsmodell mit den Salzstrukturen Köstorf-Rosenthal im Süd-

westen und Gülze-Sumte im Nordosten (Aspen SKUA® V14.5). Das Volumenmodell wurde über den SnS-Work-
flow erstellt. Die Zuweisung der Intervallgeschwindigkeiten erfolgte über Apply Script on Object für die Regions 
des Geologic Grids. 

 

7.2. Wahl der modellierten 
Geschwindigkeiten 

7.2.1. Geschwindigkeiten 
aus der Seismik 

Für die Pilotregion wurden aus den für diese Re-
gion verfügbaren seismischen Profilen die Sta-
pelgeschwindigkeiten extrahiert und in Intervall-
geschwindigkeiten umgerechnet. Stapelge-
schwindigkeiten sind ein Processingparameter, 
der so gewählt wird, dass die Reflektoren in der 
Seismik bestmöglich abgebildet werden. Die 
Stapelgeschwindigkeiten werden auch durch 
die Neigung des Reflektors beeinflusst, was 
durch eine Dip-Moveout-Korrektur behoben 
werden kann. Diese wurde allerdings erst ab 
den 1980er Jahren angewendet. Es ist nicht 
mehr nachzuvollziehen, ob bei allen untersuch-
ten Surveys eine Dip-Moveout-Korrektur bei der 
Erstellung der Stapelgeschwindigkeiten berück-
sichtigt wurde. Die Umwandlung der Stapelge-
schwindigkeiten in Intervallgeschwindigkeiten 

erfolgte zudem nicht an geologischen Horizon-
ten, sondern für die Zeiten, für die ein jeweiliger 
Geschwindigkeitswert angegeben war. In den 
Abbildungen 7, 8, 9 und 10 in Kapitel 2.10 „Ge-
schwindigkeitsdaten: Seismik“ ist die breite 
Streuung der errechneten Intervallgeschwindig-
keiten aus den Stapelgeschwindigkeiten zu er-
kennen. Das aus den Stapelgeschwindigkeiten 
erzeugte Intervallgeschwindigkeitsmodell in der 
Tiefendomäne zeigte für die Sedimentschichten 
unterhalb der Basis Lias unrealistisch hohe Ge-
schwindigkeiten von über 7000 m/s. In Abbil-
dung 41 sind die Intervallgeschwindigkeiten, die 
aus den Stapelgeschwindigkeiten berechnet 
wurden, mit derselben Farbskala, wie sie für Ab-
bildung 38 bis Abbildung 40 verwendet wurde, 
dargestellt. Hier ist außerdem zu erkennen, 
dass die Intervallgeschwindigkeiten für alle 
Schichten ab der Unterkreide und tiefer deutlich 
höher sind als im Modell nach JARITZ et al. 
(1991). 
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Abb. 41:  Kachel Dannenberg: Schnitt durch das Geschwindigkeitsmodell mit den aus den seismischen Stapelgeschwindig-

keiten abgeleiteten Intervallgeschwindigkeiten (Aspen SKUA® V14.5). Diese wurden nur für einen Teilbereich der 
Pilotregion berechnet und liegen daher nicht über den gesamten Schnitt hinweg vor. 

 

In Abbildung 42 ist die Verteilung der Intervall-
geschwindigkeiten dargestellt, die aus den Sta-
pelgeschwindigkeiten errechnet wurden. Auffäl-
lig ist, dass viele Werte über 5000 m/s liegen. 
Das Picken seismischer Geschwindigkeiten er-
folgt in nach Offset sortierten Common-Mid-
point-Gathern, wobei die Laufzeitkurve eines 
Reflexionspunktes im Untergrund eine Hyperbel 
beschreibt. Bei Verwendung einer optimalen 
Stapelgeschwindigkeit lassen sich diese Hyper-
beln zu Geraden korrigieren. Damit jedoch 
überhaupt verlässliche Stapelgeschwindigkei-

ten bestimmt werden können, muss der Emp-
fängerabstand groß genug sein, sodass die Re-
flexionen als Hyperbeln erkennbar sind. Mit zu-
nehmender Laufzeit – und damit zunehmender 
Tiefe – flachen die Hyperbeln ab und nähern 
sich unabhängig von der Geschwindigkeit Ge-
raden an. Dies führt zu wachsenden Unsicher-
heiten bei der Bestimmung der Stapelgeschwin-
digkeiten und erklärt die auffällig hohen, geolo-
gisch nicht realistischen Werte. Aus diesem 
Grund wurden die seismischen Geschwindig-
keiten nicht für das finale Modell herangezogen. 

 
Abb. 42:  Verteilung der Intervallgeschwindigkeiten, die aus den Stapelgeschwindigkeiten berechnet wurden (Aspen SKUA® 

V14.5). 
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7.2.2. Das Geschwindigkeitsmodell 
nach JARITZ et al. (1991) 

Das regionale Geschwindigkeitsmodell von 
JARITZ et al. (1991) wurde im Rahmen des 
TUNB Velo 2.0-Projekts mit Bohrungen außer-
halb des Pilotgebiets (Emtinghausen-West Z1, 
Neubruchhausen Z1, Westerstede Z1, Gander-
kesee Z1 und Z2 (4.), Reinsehlen Z1, Alvern Z1, 
Hohne Z1 (2.), Oberg Z1), die nach 1991 abge-
teuft wurden, verglichen (siehe Abb. 43). 

 

 

 
Abb. 43:  Lokationen der Bohrungen, die in Niedersachsen für die Qualitätskontrolle des Geschwindigkeitsmodells nach 

JARITZ et al. (1991) genutzt wurden (Aspen SKUA® V14.5). (Datenquelle Ländergrenzen: © GeoBasis-DE/LGLN 
2024; © GeoBasis-DE/LVermGeo SH; © GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 

 

Die im Zeitbereich vorliegenden Horizonte des 
GTA3D wurden mit den Geschwindigkeiten 
nach JARITZ et al. (1991) in Teufe gewandelt. 
Ein Vergleich dieser Teufenwerte mit den doku-
mentierten Schichtmarkern der Bohrungen 
ergab größtenteils gute Übereinstimmungen un-
ter 5 % (Tab. 5). Auffällig ist, dass für die südli-
che Bohrung Oberg Z1 die Abweichungen sehr 
groß sind. Dies resultiert aus der generell nied-
rigeren Datenüberdeckung im Süden Nieder-
sachsens. Hier muss davon ausgegangen wer-
den, dass die Genauigkeit des erstellten Ge-
schwindigkeitsmodells geringer ist. Im Süden 

Niedersachsens gibt es keine 3D-Seismikdaten, 
so dass eine Überprüfung des Geschwindig-
keitsmodells nicht mittels seismischer Proces-
sing-Geschwindigkeiten erfolgte. Außerdem ist 
zu erkennen, dass für das Quartär die Abwei-
chungen größer sind als für die anderen Schich-
ten. Im Geschwindigkeitsmodell nach JARITZ 
et al. (1991) sind Quartär und Tertiär als eine 
Schicht zusammengefasst. Außerdem gibt es 
im Quartär größere lokale Geschwindigkeitsun-
terschiede durch die geringere Kompaktion, die 
nicht mit einem regionalen Geschwindigkeits-
modell aufgelöst werden können. 
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Tab. 5:  Dokumentierte Schichtmarker und mit JARITZ et al. (1991) umgerechnete Schichtteufen. Die Farben zeigen die 
Abweichung in Prozent (grün: <5 %, gelb: 5–10 %, rot: >10 %). 

 Hohne Z1 Oberg Z1 Westerstede Z1 
 Marker Teufenfehler Marker Teufenfehler Marker Teufenfehler 

Basis Quartär 101 m -23 m 90 m nicht im  
Modell 153 m -93 m 

Basis Untermiozän n. a.  n. a.  319 m 22 m 
Basis Mitteleozän n. a.  n. a.  548 m 1 m 
Basis Untereozän 448 m -33 m n. a.  818 m -16 m 
Basis Oberkreide 1284 m -76 m n. a.  1410 m 30 m 
Basis Unterkreide 1387 m -50 m 350 m -64 m 1549 m -69 m 
Basis Dogger 1406 m -12 m 1235 m -235 m n. a.  

Basis Lias 1944 m -87 m 1655 m -260 m 2358 m 39 m 
Basis Keuper 2943 m -13 m 2059 m -301 m 3178 m -46 m 
Basis Röt 3709 m -232 m 2738 m -370 m 3817 m -8 m 
Basis  
Unterer Buntsandstein 4392 m 12 m 3315 m -172 m 4773 m 10 m 

 

 Ganderkesee Z1 Ganderkesee Z2 Emtinghausen-West Z1 
 Marker Teufenfehler Marker Teufenfehler Marker Teufenfehler 

Basis Quartär 85 m -35 m 68 m 17 m 60 m 23 m 

Basis Untermiozän 180 m 4 m 177 m 13 m 84 m nicht im  
Modell 

Basis Mitteleozän 417 m -13 m 444 m 53 m 200 m 25 m 
Basis Untereozän 806 m 26 m 951 m 37 m 491 m 74 m 
Basis Oberkreide 2027 m -48 m 2234 m -111 m 1954 m -76 m 
Basis Unterkreide 2083 m -26 m 2395 m -96 m 2032 m 7 m 
Basis Dogger n. a.  n. a.  2112 m 44 m 
Basis Lias 2593 m -43 m 2882 m -49 m 2646 m 16 m 
Basis Keuper 3049 m -51 m 3436 m 115 m 3294 m 2 m 
Basis Röt 3609 m -15 m 4042 m 133 m 3895 m 0 m 
Basis  
Unterer Buntsandstein 4339 m -33 m 4806 m 191 m 4492 m 40 m 

 

 

In Abbildung 44 ist die Verteilung der Intervall-
geschwindigkeiten für die Kachel Dannenberg 
nach dem Modell von JARITZ et al. (1991) dar-
gestellt. Auch hier ist zu erkennen, dass die Ge-
schwindigkeitsverteilung zu den für die betrach-
teten Schichten zu erwartenden Geschwindig-
keiten passt. 

 

 

 

 



GeoBerichte 56 
50 

 
Abb. 44:  Verteilung der Intervallgeschwindigkeiten im Geschwindigkeitsmodell nach JARITZ et al. (1991) (Aspen SKUA® 

V14.5). 

 

Auch in Schleswig-Holstein wurden Tests zum 
Geschwindigkeitsmodell nach JARITZ et al. 
(1991) durchgeführt, unter anderem mit den Ge-
schwindigkeiten der Bohrungen Juliusburg_2 
und Nusse_T1 sowie Seismik aus dem Zeitbe-
reich in der Pilotregion (BENSE et al. 2022). 
Auch hier ergaben die Tests Abweichungen von 
unter 5 %. Aufgrund der guten Testergebnisse 
in Niedersachsen und Schleswig-Holstein wur-
den für die Modellierung des Gesamtgebiets die 
TK100-Arbeitskarten von JARITZ et al. (1991) 
verwendet. 

7.3. Das TUNB Velo 2.0- 
Geschwindigkeitsmodell für 
Niedersachsen und Bremen 

Für Niedersachsen wurde von den 20 im TUNB-
Projekt modellierten Kacheln für 19 ein Ge-
schwindigkeitsmodell erstellt. Die Kachel Ha-
meln liegt größtenteils südlicher als das von 
JARITZ et al. (1991) untersuchte Gebiet. Aus 
demselben Grund wurde der südlichste Bereich 
der Kachel Hildesheim nicht modelliert. 
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Abb. 45:  Schnitt durch alle Geschwindigkeitsmodelle bei 2500 m Tiefe unter NN. Die Kachelgrenzen des TUNB-Projekts 

sind blau dargestellt (Aspen SKUA® V14.5). (Datenquelle Ländergrenzen: © GeoBasis-DE/LGLN 2024; © GeoBa-
sis-DE/LVermGeo SH; © GeoBasis-DE / BKG 2024 / dl-de/by-2-0) 

In Abbildung 45 ist ein Schnitt durch alle Ge-
schwindigkeitsmodelle der einzelnen Kacheln 
bei 2500 m unter NN dargestellt. Hier sind be-
reits die Salzstrukturen mit ihrer spezifischen In-
tervallgeschwindigkeit von 4500 m/s zu erken-
nen. Zudem zeigt sich, dass die Intervallge-
schwindigkeiten in der dargestellten Tiefe nach 

Süden hin zunehmen. Abbildung 46 bis Abbil-
dung 49 zeigen Schnitte durch die Geschwin-
digkeitsmodelle ausgewählter Kacheln. Die 
Lage der Schnitte ist in Abbildung 45 durch 
schwarze Linien eingezeichnet. 

 
Abb. 46:  Schnitt in West-Ost-Richtung durch das Geschwindigkeitsmodell der Kachel Bremerhaven (Aspen SKUA® V14.5). 
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Beim Schnitt durch das Geschwindigkeitsmo-
dell der Kachel Bremerhaven (Abb. 46) sind die 
drei Salzstrukturen Cuxhaven-Spieka, Alten-
bruch-Baverstedt und Osterbruch-Basdahl (von 
West nach Ost) deutlich an ihrer konstanten Ge-
schwindigkeit von 4500 m/s zu erkennen. Zu-
dem ist die generelle Geschwindigkeitszu-
nahme mit der Tiefe zu beobachten. Zwischen 
Profilmeter 22500 und 25000 sieht man in 1000 

bis 2000 m Tiefe die Geschwindigkeitszunahme 
in der Unterkreide, die den größten Gradienten 
aller Schichten hat. Auffällig sind auch die deut-
lich höheren Intervallgeschwindigkeiten im Un-
teren und Mittleren Buntsandstein von 5000 m/s 
(Tiefe 4000–5600 m), der auf dem Zechstein 
(konstante Geschwindigkeit von 4500 m/s) ab-
gelagert ist. 

 
Abb. 47:  Schnitt in West-Ost-Richtung durch das Geschwindigkeitsmodell der Kachel Bremen mit den Salzstrukturen  

Arsten-Osterholz (westlich) und Quelkhorn-Schaphusen (östlich) (Aspen SKUA® V14.5). 

 

Abbildung 47 zeigt einen West-Ost-Schnitt 
durch die Kachel Bremen. Der mittigere Salz-
stock Arsten-Osterholz hat eine Überhangstruk-
tur im zentralen Bereich, so dass darunter Bunt-
sandstein liegt. An diesem Salzstock erkennt 
man zudem stufig aussehende Flanken, was 
durch die Auflösung des Voxets von 200 x 200 
x 20 m entsteht. Die Salzstruktur im Osten des 
Profils ist Quelkhorn-Schaphusen. Das Profil 
schneidet diese an deren südlichem Ende, 
wodurch im Profil nur die Überhangstruktur 
sichtbar ist. Auffällig ist außerdem in etwa 

800 m Tiefe der hohe Kontrast der Geschwin-
digkeiten beim Übergang vom Tertiär (an der 
Basis liegen die Intervallgeschwindigkeiten bei 
2000–2200 m/s) zur Oberkreide (unter deren 
Top liegen die Geschwindigkeiten bei über 
3000 m/s). Dies kann durch eine höhere Kom-
paktion der tiefer liegenden Oberkreide und ei-
nen Wechsel der Lithologie (Tab. 2) erklärt wer-
den. Auf dem Salzstock Arsten-Osterholz liegen 
vorwiegend tertiäre und quartäre Ablagerungen 
und nur sehr geringmächtig Ablagerungen aus 
der Kreide. 

 
Abb. 48:  Schnitt in Nord-Süd-Richtung durch das Geschwindigkeitsmodell der Kachel Vechta (Aspen SKUA® V14.5).  

Störungen sind als blaue Linien eingezeichnet. 
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Im Nord-Süd-Schnitt durch die Kachel Vechta in 
Abbildung 48 sind zusätzlich die Störungen aus 
dem TUNB-Modell (SATTLER et al. 2022) darge-
stellt. Insbesondere bei den Störungen zwi-
schen Profilmeter 8000 und 10000 sind die Stö-
rungsversätze der Schichten auch in den Inter-
vallgeschwindigkeiten erkennbar. Zwischen 
Profilmeter 14000 und 18000 und südlich von 
Profilmeter 23000 sind die Intervallgeschwindig-
keiten mit Werten um 2200 m/s in Tiefen bis 
1000 m deutlich langsamer als im restlichen 

Schnitt in selbiger Tiefe (um 3400 m/s). Die 
langsameren Geschwindigkeiten entstehen 
durch die geringere Tiefe der Unterkreide, die 
niedrigere Geschwindigkeiten aufweist als die 
Oberkreide, welche hier erodiert ist. Wie in dem 
Schnitt in 2500 m Tiefe in Abbildung 45 ist auch 
hier der Anstieg der Geschwindigkeiten in die-
ser Tiefe nach Süden hin erkennbar, was aus 
einer geringeren Tiefe der Buntsandstein-
schichten mit höheren Intervallgeschwindigkei-
ten resultiert. 

 
Abb. 49:  Schnitt in West-Ost-Richtung durch das Geschwindigkeitsmodell der Kachel Hildesheim (Aspen SKUA® V14.5). 

 

Im Schnitt durch die Kachel Hildesheim 
(Abb. 49) sind der Salzstock Lehrte-Sarstedt 
und die Versätze an der Störung bei Profilmeter 
24000 deutlich zu erkennen. Auch bei diesem 
Schnitt ist erkennbar, dass die Schichten mit hö-
herer Intervallgeschwindigkeit im Süden Nieder-
sachsens in geringerer Tiefe liegen als im Nor-
den. 

7.4. Umwandlung von Seismik von der 
Zeit- in die Tiefendomäne 

In Abbildung 50 ist eine Übersichtskarte von 
Niedersachsen dargestellt, die die beim LBEG 
verfügbaren 2D- und 3D-Seismikdaten zeigt 
(Stand 2022). Von diesen liegen 75 % der 3D-
Daten und 83 % der 2D-Daten ausschließlich im 
Zeitbereich vor. Für eine Nutzung in der Tiefen-
modellierung ist jedoch eine Umwandlung in 
den Tiefenbereich erforderlich. Daher wurde un-
tersucht, inwiefern sich das TUNB Velo 2.0-Ge-
schwindigkeitsmodell für diese Konvertierung 
eignet. 
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Abb. 50:  Am LBEG vorhandene Seismik für Niedersachsen (Quelle: SATTLER et al. 2022). 

 

Für die Tests wurde der 3D-Survey Soltau 2013 
verwendet. Für diesen Survey liegen Ergeb-
nisse der Zeit- und Tiefenmigration sowie ein 
von der Processing-Firma geliefertes Ge-
schwindigkeitsmodell im Tiefenbereich vor. 
Dadurch war ein Vergleich des gelieferten Ge-
schwindigkeitsmodells mit dem TUNB Velo 2.0-
Geschwindigkeitsmodell möglich. Zudem konn-
te die gelieferte Seismik aus dem Zeitbereich 
mit den TUNB Velo 2.0-Geschwindigkeiten in 
die Tiefe konvertiert werden, um sie mit dem ge-
lieferten Ergebnis der Tiefenmigration zu ver-
gleichen. 
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Abb. 51:  Lage des 3D-Surveys Soltau 2013. Die in Abbildung 52 bis Abbildung 58 gezeigte Sektion ist rot markiert.  

(Datenquelle Ländergrenzen: © GeoBasis-DE/LGLN 2024; © GeoBasis-DE / BKG 2024 / dl-de/by-2-0.) 

 

Für die Tests wird eine Sektion aus dem südli-
chen Teil des Surveys gezeigt (Lage in 
Abb. 51). Diese ist in Abbildung 52 im Zeitbe-
reich dargestellt und in Abbildung 53 nach der 
Tiefenmigration. In Abbildung 54 sind zusätzlich 
die im TUNB-Projekt modellierten Horizonte 
eingezeichnet. 

 

 
Abb. 52:  Sektion aus der 3D-Seismik im Zeitbereich (Aspen SKUA® V14.5). 



GeoBerichte 56 
56 

 
Abb. 53:  Sektion aus der 3D-Seismik im Tiefenbereich (Aspen SKUA® V14.5). 

 
Abb. 54:  Sektion aus der 3D-Seismik im Tiefenbereich mit den Horizonten aus dem TUNB-Modell (SATTLER et al. (2022); 

Aspen SKUA® V14.5). 

 

Ein Vergleich des gelieferten Geschwindigkeits-
modells in Abbildung 55 mit dem TUNB Velo 
2.0-Geschwindigkeitsmodell für dieselbe Sek-
tion (Abb. 56) ergibt, dass die Geschwindigkei-
ten für bestimmte Horizonte sehr gut überein-
stimmen. Dies zeigt sich beispielsweise in der 
Oberkreide, für die beide Geschwindigkeitsmo-
delle eine deutliche Geschwindigkeitszunahme 
mit der Tiefe aufweisen. Auch in der darunter 
liegenden Unterkreide sowie im Keuper sind die 
Intervallgeschwindigkeiten sehr ähnlich. Unter-
schiede treten hingegen in den quartären und 
tertiären Ablagerungen im westlichen Teil der 

Sektion auf, wo die Geschwindigkeiten im 
TUNB Velo 2.0-Modell um etwa 150 m/s höher 
liegen (ungefähr 1800 m/s in den seismischen 
Geschwindigkeiten im Vergleich zu 1950 m/s 
beim TUNB Velo 2.0-Modell). Gleiches gilt für 
den Oberen Buntsandstein, der ebenfalls im 
TUNB Velo 2.0-Modell durch bis zu 550 m/s hö-
here Werte charakterisiert ist. Die absoluten 
Geschwindigkeitswerte für den Oberen Bunt-
sandstein liegen im TUNB Velo 2.0-Geschwin-
digkeitsmodell bei etwa 5000 m/s und in den 
Geschwindigkeiten aus der Seismik bei etwa 
4500 m/s. 
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Abb. 55:  Geliefertes Geschwindigkeitsmodell im Tiefenbereich (Aspen SKUA® V14.5). 

 
Abb. 56:  TUNB Velo 2.0-Geschwindigkeitsmodell für dieselbe Sektion wie in Abbildung 55 (Aspen SKUA® V14.5). 

 
Abb. 57:  Prozentuale Abweichung der beiden Geschwindigkeitsmodelle. Positive Werte bedeuten höhere Intervallge-

schwindigkeiten im TUNB Velo 2.0-Modell (Aspen SKUA® V14.5). 
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In Abbildung 57 sind die prozentualen Abwei-
chungen der Geschwindigkeitsmodelle darge-
stellt. Auch hier sind die Abweichungen im Obe-
ren Buntsandstein sowie Teilen des Quartärs 
und des Tertiärs sichtbar. 

Die Sektion in Abbildung 58 wurde mit dem 
TUNB Velo 2.0-Geschwindigkeitsfeld aus dem 
Zeitbereich (Abb. 52) in den Tiefenbereich kon-
vertiert. Zur Orientierung sind erneut die TUNB-
Horizonte eingezeichnet. An diesen sind die Un-
terschiede zur tiefenmigrierten Seismik 

(Abb. 54) erkennbar. Im östlichen Teil liegen die 
Horizonte auch in der konvertierten Sektion auf 
den Reflektoren. Im westlichen Bereich des 
Profils sind Differenzen in der Tiefenlage der 
Reflektoren im Vergleich zu den Horizonten er-
kennbar, die aus den unterschiedlichen Inter-
vallgeschwindigkeiten im Quartär/Tertiär und im 
Oberen Buntsandstein resultieren. Die maxi-
male Differenz für die Basis Zechstein liegt bei 
etwa 150 m (ca. 3 %). 

 
Abb. 58:  Sektion durch die 3D-Seismik aus dem Zeitbereich, die mit den Geschwindigkeiten aus dem TUNB Velo 2.0- 

Projekt in den Tiefenbereich konvertiert wurde (Aspen SKUA® V14.5). 

 

Für die Surveys Soehlingen_2016 (ebenfalls 
Kachel Soltau) und Scholen_Ridderade_2015 
(Kachel Vechta) wurden identische Tests durch-
geführt. Auch hier ergaben sich maximale Ab-
weichungen von ca. 150 m für die Basis Zech-
stein (ca. 3 %). 

7.5. Ungenauigkeiten 

Das TUNB Velo 2.0-Geschwindigkeitsmodell ist 
ein flächendeckendes, regionales Geschwindig-
keitsmodell und kann keine lokale Geschwindig-
keitsanalyse ersetzen. Ungenauigkeiten entste-
hen durch die Auflösung des bei der Volumen-
modellierung verwendeten Strukturmodells aus 
dem TUNB-Projekt, Vereinfachungen bei der 
Anwendung des Workflows zur Volumenmodel-
lierung und Parametrisierung sowie durch Un-
genauigkeiten der verwendeten Geschwindig-
keiten von JARITZ et al. (1991). 

Im vorangegangenen TUNB-Projekt ergaben 
sich Probleme durch die heterogene Verteilung 
der Belegdaten beim Aufbau des Strukturmo-
dells, etwa hinsichtlich der Verfügbarkeit von 
Bohrungen und 3D-seismischen Tiefenmigrati-
onsergebnissen. Zudem waren die verwende-
ten Eingangsdaten teilweise widersprüchlich, 
beispielsweise durch sich überlagernde Hori-
zonte, was von den jeweiligen Bearbeiterinnen 
und Bearbeitern nur begrenzt korrigiert werden 
konnte. Aufgrund der im TUNB-Projekt verfüg-
baren Ressourcen war es außerdem nicht mög-
lich, sämtliche Salzstrukturen zu modellieren 
(Anhang, Tab. 6). Eine detaillierte Beschrei-
bung der Ungenauigkeiten im vorangegange-
nen TUNB-Projekt ist im Kapitel 4.3 „Probleme 
und Diskrepanzen“ in SATTLER et al. (2022) be-
schrieben. 

Beim Einsatz des SnS-Workflows entstehen 
ebenfalls Ungenauigkeiten, da dessen Anwen-
dung immer einen Kompromiss zwischen einer 
möglichst genauen Anpassung der Daten und 
einem möglichst glatten Modell darstellt. 
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Die regionale Verteilung von Bohrungen mit Ge-
schwindigkeitsinformationen war für die Genau-
igkeit der Eingangsdaten von JARITZ et al. 
(1991) und somit für die Unsicherheiten des Mo-
dells entscheidend. Diese Verteilung kann je-
doch als schlecht betrachtet werden, da sie Ge-
biete mit mehr als 10 Geophonversenkmessun-
gen pro Blatt der TK25 und solche mit weniger 
als einer auf 10 Blätter der TK25 umfasste. Da-
her versuchten die Autoren, Kenntnisse der re-
gionalen Geologie, wie beispielsweise die maxi-
mal erreichte Versenkungstiefe, in die Karten 
der theoretischen Oberflächengeschwindigkei-
ten einzubeziehen. 

Bei den Tests, bei denen die Geschwindigkeiten 
nach JARITZ et al. (1991) mit den Markern aus 
Bohrungen (Kapitel 7.2 „Wahl der modellierten 
Geschwindigkeiten“) verglichen wurden, war 
der prozentuale Teufenfehler bei der südlichen 
Bohrung Oberg Z1 größer als bei den anderen 
untersuchten Bohrungen. Es muss davon aus-
gegangen werden, dass im Süden Niedersach-
sens der Fehler des Geschwindigkeitsmodells 
größer ist als weiter im Norden. Diese Ungenau-
igkeiten konnten jedoch nicht innerhalb der Pro-
jektlaufzeit quantifiziert werden. 

Sowohl in den Tests aus Kapitel 7.2 „Wahl der 
modellierten Geschwindigkeiten“ als auch im 
Vergleich zum Geschwindigkeitsmodell aus der 
Seismik (Kapitel 7.4 „Umwandlung von Seismik 
von der Zeit- in die Tiefendomäne“) zeigten sich 
größere Unsicherheiten bei den Geschwindig-
keiten im Quartär. Für ein regionales Geschwin-
digkeitsmodell im Übersichtsmaßstab erscheint 
die Zusammenfassung von Tertiär und Quartär, 
wie bei JARITZ et al. (1991), sinnvoll. Aufgrund 
der komplexen Geologie der quartären Ablage-
rungen, insbesondere der teils über 400 m tief 
eingeschnittenen elsterzeitlichen Rinnen, ist für 
detailliertere Untersuchungen jedoch eine diffe-
renziertere Erfassung der seismischen Ausbrei-
tungsgeschwindigkeiten innerhalb des Quartärs 
erforderlich. 

8. Ausblick 

Das aktuelle TUNB Velo 2.0-Modell bildet die 
zentrale Grundlage, um das bestehende Ge-
schwindigkeitsmodell künftig – auch im regiona-
len Maßstab – weiter zu verbessern. Besonders 
durch die Integration neuerer VSP-Messungen 

sind gezielte Optimierungen möglich. Darüber 
hinaus sollten lokale 3D-Geschwindigkeitsmo-
delle aus seismischen Untersuchungen berück-
sichtigt und gegebenenfalls in das Modell über-
nommen werden. Ein systematischer Abgleich 
der seismisch abgeleiteten Geschwindigkeiten 
mit den in vorhandenen Bohrungen ermittelten 
Werten ist dabei essenziell, um potenzielle Dif-
ferenzen zu identifizieren. 

Neuere lokale Geschwindigkeitsanalysen, wie 
jene für die Salzstruktur Gorleben (BRÜCKNER-
RÖHLING et al. 2002) oder das Gebiet um die 
Asse (SCHOLZE & BUXBAUM-CONRADI 2023), 
sollten ebenfalls mit dem TUNB Velo 2.0-Modell 
verglichen und bei Bedarf integriert werden. 

Zukünftig ist außerdem zu prüfen, welche me-
thodische Vorgehensweise sich am besten für 
ein Update des TUNB Velo 2.0-Modells eignet. 
Möglich ist sowohl eine direkte Anpassung der 
Intervallgeschwindigkeiten im Volumenmodell 
als auch eine Modifikation der Gradienten und 
der theoretischen Oberflächengeschwindigkeit, 
auf deren Basis anschließend die Intervallge-
schwindigkeiten neu berechnet werden. Eine 
weitere Möglichkeit zur Verbesserung der Inter-
vallgeschwindigkeiten wäre, weitere Horizonte 
in das Modell einzufügen, um die Unterteilung 
der Tiefenabschnitte zur Berechnung der Inter-
vallgeschwindigkeiten zu verfeinern. Insbeson-
dere sind hierbei das Quartär, dessen Basis ak-
tuell am LBEG neu modelliert wird (MEINSEN 
et al. 2025), sowie der Muschelkalk zu nennen. 
Letzterer ist in den Modellen von Mecklenburg-
Vorpommern, Brandenburg und Sachsen-An-
halt ebenfalls vorhanden und weist dort relativ 
hohe Intervallgeschwindigkeiten um 5100 m/s 
auf. 

Während der Projektlaufzeit wurden die Gren-
zen zu Schleswig-Holstein, Mecklenburg-Vor-
pommern, Brandenburg und Sachsen-Anhalt 
harmonisiert. Für die Nordsee wurde im Rah-
men von TUNB Velo 2.0 systematisch das Po-
tenzial zur Weiterentwicklung des erarbeiteten 
Geschwindigkeitsmodells aus TUNB Phase 2 
getestet. Zudem existiert für die Niederlande ein 
seismisches Geschwindigkeitsmodell bis ein-
schließlich des Oberen Rotliegenden (VAN 
DALFSEN et al. 2006). Auch hier wäre ein Ver-
gleich der Intervallgeschwindigkeiten und eine 
Grenzharmonisierung erstrebenswert. 
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9. Zusammenfassung 

Das TUNB Velo 2.0-Modell ist das erste regio-
nale 3D-Geschwindigkeitsmodell für das Nord-
deutsche Becken. Für Niedersachsen und Bre-
men deckt es flächenhaft nahezu das gesamte 
im vorangegangenen TUNB-Projekt modellierte 
Gebiet ab und basiert auf dem regionalen Ge-
schwindigkeitsmodell von JARITZ et al. (1991). 

Die Geschwindigkeitsmodelle der beteiligten 
staatlichen geologischen Dienste basieren auf 
unterschiedlichen Datengrundlagen. Neben 
verschiedenen bestehenden regionalen Model-
len wurden auch neu entwickelte Konzepte ver-
wendet. Die Intervallgeschwindigkeiten an den 
Ländergrenzen wurden harmonisiert.  

Aufgrund seines großräumigen Maßstabs kann 
das Modell lokale Geschwindigkeitsstudien 
nicht ersetzen, jedoch als Ausgangsmodell für 
solche Untersuchungen dienen – auch im Rah-
men der Analyse seismischer Geschwindigkei-
ten. Darüber hinaus findet das TUNB Velo 2.0-
Geschwindigkeitsmodell auch in der Seismolo-
gie Anwendung. Es liefert ein deutlich realisti-
scheres Abbild der oberen Erdkruste als die üb-
licherweise angenommene Geschwindigkeits-
zunahme entlang eines einheitlichen Gradien-
ten. Da Erdbebenwellen je nach Ausbreitungs-
weg vergleichsweise lange durch die obere Erd-
kruste laufen, hat eine höhere Genauigkeit des 
Geschwindigkeitsmodells in diesem Bereich ei-
nen erheblichen Einfluss auf die Qualität der 
seismologischen Ergebnisse. 

Das TUNB Velo 2.0 Geschwindigkeitsmodell für 
Niedersachsen und Bremen ist in GST auf 
https://3d.lbeg.de/ veröffentlicht. Auf Anfrage 
sind die Intervallgeschwindigkeiten im Tiefenbe-
reich sowie die Durchschnittsgeschwindigkeiten 
im Zeitbereich jeweils im Aspen SKUA® Voxet-
Format (.vo) und als Textfiles (.txt) verfügbar. 
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11. Anhang 

11.1. Datengrundlage 

11.1.1. Salzstrukturen 

 

 

 

 

Tab. 6:  Im TUNB Velo 2.0-Projekt verwendete Salzstrukturen und deren Quelle. 

Kachel Salzstruktur Quelle 

AUR 

Barkholt TUNB3D 
Bedekaspel TUNB3D 
Berdum-Jever TUNB3D 
Etzel TUNB3D 
Marga TUNB3D 
Meta TUNB3D 
Mira TUNB3D 
Monika TUNB3D 
Spiekeroog TUNB3D 
Strackholt TUNB3D 
Suederneuland TUNB3D 
Timmel TUNB3D 
Westdorf TUNB3D 
Wichter-Ee TUNB3D 
Wittmund TUNB3D 

BHV 

Altenbruch-Beverstedt TUNB3D 
Bramel TUNB3D 
Cuxhaven-Spieka TUNB3D 
Dedesdorf TUNB3D 
Neufelder-Sand TUNB3D 
Oldendorf-II TUNB3D 
Oldenswort-Sued TUNB3D 
Osterbruch-Basdahl TUNB3D 

BRS 

Allertal Nicht modelliert 
Asse Nicht modelliert 
Bechtsbüttel Nicht modelliert 
Beienrode Nicht modelliert 
Calberlah GTA3D 
Ehmen GTA3D 
Lehre Nicht modelliert 
Neindorf Nicht modelliert 
Nettgau GTA3D 
Offleben Nicht modelliert 
Örrel GTA3D 
Salzdahlum Nicht modelliert 
Schneflingen – Ehra GTA3D 
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Tab. 6:  Im TUNB Velo 2.0-Projekt verwendete Salzstrukturen und deren Quelle (Fortsetzung). 

Kachel Salzstruktur Quelle 

BRS 

Vorhop GTA3D 
Wesendorf GTA3D 
Weyhausen GTA3D 
Wittingen Nicht modelliert 

CEL 

Böstlingen-Sülze-Weesen-Lutterloh GTA3D 
Gifhorn TUNB3D 
Hoefer TUNB3D 
Hope TUNB3D 
Wathlingen GTA3D 
Wienhausen GTA3D 
Wietze-Hambueren TUNB3D 
Wolthausen TUNB3D 

DAN 

Bockleben TUNB3D 
Dannenberg TUNB3D 
Doemitz TUNB3D 
Geesthacht TUNB3D 
Gorleben TUNB3D 
Gr-Heide-Siemen TUNB3D 
Guelden-Braudel TUNB3D 
Guelze-Sumte TUNB3D 
Kaarssen TUNB3D 
Koestorf-Rosenthal TUNB3D 
Wustrow TUNB3D 

EMS 

Boerger TUNB3D 
Boertange TUNB3D 
Gehlenberg TUNB3D 
Lathen TUNB3D 
Liener-Garen TUNB3D 
Molbergen TUNB3D 
Molbergen-West TUNB3D 
Neusustrum TUNB3D 
Oberlanger-Tenge TUNB3D 
Vrees TUNB3D 
Wahn TUNB3D 

HAN 

Schessinghausen Nicht modelliert 
Husum Nicht modelliert 
Bokeloh Nicht modelliert 
Benthe Nicht modelliert 

HBR 

Adolphsdorf TUNB3D 
Arsten-Osterholz TUNB3D 
Aschwarden TUNB3D 
Breddorf* TUNB3D 

* Die Salzstruktur Breddorf liegt zu großen Teilen auf der Kachel SOL und ragt nur ca. 300 m lateral in die Kachel HBR. 
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Tab. 6:  Im TUNB Velo 2.0-Projekt verwendete Salzstrukturen und deren Quelle (Fortsetzung). 

Kachel Salzstruktur Quelle 

HBR 

Grueppenbuehren TUNB3D 
Lesum TUNB3D 
Lilienthal TUNB3D 
Quelkhorn-Schaphusen TUNB3D 
Teufelsmoor TUNB3D 
Thedinghausen-Emtinghausen TUNB3D 
Wachendorf TUNB3D 

HIL 

Berkhoepen TUNB3D 
Flachstoeckheim TUNB3D 
Groß-Ilsede-Moelme TUNB3D 
Lehrte-Sarstedt TUNB3D 
Rolfsbuettel-Broistedt TUNB3D 
Salzgitter TUNB3D 
Thiede TUNB3D 
Werla-Burgdorf TUNB3D 

NOR 

Juist-Nord-Emshoern TUNB3D 
Lisa-Moevensteert TUNB3D 
Manuela-Norderney TUNB3D 
Maria-Groothusen TUNB3D 
Lia TUNB3D 
Paapsand TUNB3D 
Uttum TUNB3D 
Wybelsum TUNB3D 

OLD 

Emden TUNB3D 
Emden-Sued-Rhaude TUNB3D 
Hasbruch TUNB3D 
Neuenhuntorf TUNB3D 
Oldenburg-Sued TUNB3D 
Sagermeer TUNB3D 
Scharrel-Oldenburg-Nordwest TUNB3D 

SOL 

Bommelsen TUNB3D 
Breddorf* TUNB3D 
Bruemmerhof TUNB3D 
Dethlingen TUNB3D 
Soehlingen TUNB3D 
Soltau TUNB3D 
Stemmen-Otter-Todtshorn TUNB3D 
Taaken-Ostervesede TUNB3D 
Volkensen TUNB3D 
Volkwardingen TUNB3D 

UEL 
Bahlburg TUNB3D 
Bahnsen TUNB3D 

* Die Salzstruktur Breddorf liegt zu großen Teilen auf der Kachel SOL und ragt nur ca. 300 m lateral in die Kachel HBR. 
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Tab. 6:  Im TUNB Velo 2.0-Projekt verwendete Salzstrukturen und deren Quelle (Fortsetzung). 

Kachel Salzstruktur Quelle 

UEL 

Niendorf-II-Bodenteich TUNB3D 
Bokel TUNB3D 
Ebstorf-Wettenbostel TUNB3D 
Egestorf-Soderstorf TUNB3D 
Horndorf TUNB3D 
Kolkhagen TUNB3D 
Lueneburg TUNB3D 
Rosche-Thondorf TUNB3D 
Varbitz TUNB3D 

VEC Blenhorst TUNB3D 

VER 

Ahrensheide TUNB3D 
Eilte TUNB3D 
Eitzendorf-Lichtenhorst TUNB3D 
Grethem-Buechten TUNB3D 
Hamwiede TUNB3D 
Rethem TUNB3D 
Verden TUNB3D 
Wedehof TUNB3D 

WHV 

Arngast TUNB3D 
Harle-Riff TUNB3D 
Jaderberg TUNB3D 
Roter-Sand TUNB3D 
Ruestringen TUNB3D 
Scharhoern-Mellum TUNB3D 
Seefeld TUNB3D 
Wangerooge TUNB3D 

WIN 

Bevern-Oldendorf TUNB3D 
Harsefeld TUNB3D 
Hamelwoerden TUNB3D 
Meckelfeld TUNB3D 
Moisburg TUNB3D 
Sottorf TUNB3D 
Sproetze TUNB3D 
Stade TUNB3D 
Toeps TUNB3D 
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11.2. Integration des Wealdens 
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11.3. Modellierungsschritte in Aspen SKUA® V14.5 

11.3.1. Modellierung des Wealdens 

■ Interpolation der Mächtigkeiten des Wealdens auf einer Surface mittels des Application 
Wizards (Mindestmächtigkeit 25 m). 

■ Erzeugen der Topfläche der TUNB-Schicht Oberes Jura (Malm und Wealden): 
■ Erzeugen einer geschlossenen Surface und Schieben über die Geländeoberkante mittels Apply 

Script On Object. 
■ Nach-unten-Verschieben der Surface über den Befehl Remove Crossovers -> Push down itera-

tiv für jeden Horizont von oben bis unter die Basis Unterkreide. 
■ Projizieren einer Surface mit der Ausdehnung des Horizontes Basis Malm aus dem TUNB3D-

Modell auf diese Surface. 
■ Übertragen der Wealden-Mächtigkeit auf die Topfläche mittels Transfer Property By Vertical 

Projection. 
■ Subtrahieren der Wealden-Mächtigkeit vom aktuellen Tiefenwert Z der Topfläche. 
■ Bereiche, für die keine Mächtigkeitswerte für das Wealden interpoliert wurden, der Malm je-

doch verbreitet ist, haben den Z-Wert No-Data Value und konnten über Region -> Initialize from 
Property No-Data Value und Region -> Delete Triangles gelöscht werden. 

■ Über Remove Crossovers -> Push up mit der Basisfläche Malm als Referenz wurde sicherge-
stellt, dass die Basisfläche Wealden nicht unter der Basisfläche des Malms liegt. 

■ Die Basisfläche Wealden wurde auf die Bereiche geschnitten, für die das Wealden laut dem 
Paläogeographischen Atlas (SCHOTT et al. 1967) verbreitet ist. Dazu wurden aus der Wealden-
Basisfläche Parts erzeugt mit dem Befehl Surface -> Cut -> By Curves (X=0, Y=0, Z=-10000, 
Haken bei Two Ways) und dem Umriss des Wealdens. Die Parts, in denen in der Karte keine 
Verbreitung des Wealdens eingezeichnet ist, wurden über Surface -> Tools -> Part -> Delete 
Selection entfernt. 

11.3.2. Aufbereiten der VNN100-Geschwindigkeiten nach JARITZ et al. (1991) 

■ Um ausgehend von den Isolinien flächendeckende VNN-Werte interpolieren zu können, müssen 
die Stützstellen der Isolinien einen regulären Abstand besitzen. Mittels Tools -> Filter -> Seg-
ment Length und Tools -> Densify wurde dieser auf etwa 200 m gesetzt. 

■ Um die VNN-Werte interpolieren zu können, wird eine Surface benötigt. Dafür wurde ein Poly-
gon um Niedersachsen gepickt (Curve -> New -> Digitize in 3D View -> Polygon), bei dem mit-
tels Tools -> Densify der Abstand der Stützstellen auf 500 m gesetzt wurde. Über Surface -> 
New -> From Closed Curve wurde aus diesem Polygon die Surface erstellt. Diese ist eine trian-
gulierte Fläche, bei der die Größe der Dreiecke zu der Auflösung der digitalisierten Isolinien 
sinnvoll sein sollte. Über Tools -> Split wurde die Größe der Dreiecke an die Isolinien ange-
passt, so dass deren Kantenlänge bei etwa 200 m lag. 

■ Um die digitalisierten Isolinien und die einzelnen VNN-Werte auf der Fläche interpolieren zu 
können, mussten diese als PointsSet zusammengefasst werden (PointsSet -> New -> From 
PointsSet, Curve or Surface, dabei die Properties mit auswählen).  

■ Im Application Wizard konnte mit dem PointsSet die Interpolation durchgeführt werden (Appli-
cation -> Wizards -> Operations on Object Properties -> Paint Surface from Discrete Properties 
Points by Interpolation). Dabei wurden so viele Iterationen angewendet, bis keine Änderungen 
bei den Werten mehr erkennbar waren.  

■ In den Arbeitskarten hatten JARITZ et al. (1991) über Pfeile größeren Regionen konstante VNN-
Werte zugewiesen. Um diese korrekt zu interpolieren, wurden Regions auf einer Surface über 
den Region Editor gepickt und anschließend über Compute on Object konstante VNN-Werte zu-
gewiesen. Die Bereiche mit VNN-Werten wurden als PointsSet exportiert und dann als Con-
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straints bei der zu interpolierenden Surface gesetzt (Surface -> Constraints -> Set Property 
Control Points). 

■ Weitere Iterationen der Interpolation wurden über Surface -> Interpolation -> Interpolate Pro-
perty durchgeführt. 

11.3.3. Erzeugen eines Volumenmodells über den Structure and 
Stratigraphy-Workflow 

Umgang mit Salzstrukturen im SnS-Workflow 
Vorgehen zum Modellieren der Salzstrukturen als geschlossene Köper: 

■ Erstellen von PointsSets aus den originalen Flächen der Salzstrukturen aus dem TUNB3D- 
bzw. GTA3D-Modell (PointsSet -> New -> From Object Region).  

■ Erzeugen von ellipsenförmigen Körpern aus den PointsSets (Surface -> New -> Ellipsoid from 
PointsSet (Number of split 3, Variance Scale 2)). 

■ Setzen der originalen Salzstrukturen als Constraints (Surface -> Constraints -> Control Points  
-> Set Control Points (Optimized shooting direction)). 

■ Interpolation der Flächen an die Salzstrukturen (Surface -> Interpolation -> Geometry On Entire 
Surface). 

Horizontmodellierung im Schritt Modeling Horizons 
Vorgehen zur Korrektur, wenn der SnS-Workflow einen Horizont in Bereiche modelliert, in denen 
dieser nicht vorkommt: 

■ Erzeugen eines 2D-Grids aus der Surface des Horizonts (2D-Grid -> New -> From Surface). 
■ Schließen kleinerer Lücken, beispielsweise an Störungen, mittels 2D-Grid -> Tools -> Fill Holes 

und Closing auswählen.  
■ Aus dem 2D-Grid kann eine Curve erzeugt werden (Curve -> New -> From Surfaces Borders -> 

2D-Grid Border), die den äußeren Umriss der Schicht (Outline) darstellt. 
■ Die Curve besteht in der Regel aus mehreren Parts, wenn der Horizont beispielsweise im Be-

reich von Salzstrukturen Lücken hat. Diese Parts müssen gelöscht werden: Curve -> Tools -> 
Part -> Delete Selection.  

■ Falls es Lücken im Horizont gibt, die nicht gefüllt werden sollen, so muss die Outline um diesen 
Teil erweitert werden: jeweils außen und innen ein Segment löschen (Curve -> Tools -> Seg-
ment -> Delete) und die offenen Knoten miteinander verbinden (Curve -> Tools -> Node -> 
Bridge). Die Curve muss dann noch mittels Reshape Curve im schmalen Segment übereinan-
der geschoben werden.  

■ Die finale Outline muss dann dem zugehörigen Horizon Feature zugewiesen werden.  
■ Im SnS-Workflow muss zurück zum Schritt Selecting Data: Horizons gegangen werden. Hier 

wurde die Outline ausgewählt und die Role auf Non-erosion Outline gesetzt. 
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